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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Overview

Overview of Tasks from the Inventory Management Work
Area  
Use the task panel on the Inventory Management work area to access your inventory, shipping, and receiving tasks.

Click Show Tasks in the task pane to toggle between these main categories:

• Inventory

• Counts

• Shipments

• Picks

• Receipts

Once you select a main category, you can view all the tasks in that category. Click a task link to open the UI pages for
that task.

Note:  The list of tasks that you can view and access depends on the products that your enterprise has licensed and
configured, and the security privileges and roles assigned to your user account.

Inventory
Inventory tasks include both inventory-related and consigned inventory-related tasks.

This table shows the Inventory tasks.

Task Description

Manage Item Quantities
 

Search, review, and maintain item quantities.
 

Create Miscellaneous Transaction
 

Create a miscellaneous inventory transaction.
 
A miscellaneous transaction is a transaction, such as a miscellaneous issue or miscellaneous receipt
that you can use to issue material.
 

Create Subinventory Transfer
 

Create inventory transfer transaction between two subinventories.
 

Create Interorganization Transfer
 

Create inventory transfer transaction between two organizations.
 

Create Project Transfer
 

Create an inventory transfer transaction between two projects.
 

Manage Reservations and Picks
 

Search, review, and maintain reservations and picks.
 

1
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Task Description

Create linkages between supply and demand sources by using reservations and picks.
 

Manage Movement Requests
 

Search, review, and maintain movement requests.
 
Movement requests are requests for the movement of material within an inventory organization.
 

Manage Transfer Orders
 

Search, review, and maintain transfer orders.
 
Transfer orders represent demand and supply in a single document.
 

Manage Pending Transactions
 

Search, review, and maintain pending inventory transactions.
 

Review Completed Transactions
 

Review completed inventory transaction details.
 

Manage Reservation Interface
 

Upload reservation data for processing.
 
Use the Reservation Interface to view, create, process, and delete inventory reservation requests in the
Oracle Fusion Cloud Inventory Management INV_RESERVATION_INTERFACE table.
 

Manage Lots
 

Search, review, and maintain lot information.
 

Manage Serial Numbers
 

Search, review, and maintain serial number information.
 

Confirm Pick Slips
 

Enter details of picked material and confirm a pick slip.
 

Manage Inventory Balance Messages in
Spreadsheet
 

Review and edit the pending or failed inventory balance messages from external systems.
 

Review Item Supply and Demand
 

Search for and review the supply and demand information for an item.
 

Review Replenishment Requests in
Spreadsheet
 

Review and update pending or failed inventory replenishment requests.
 

This table shows the Consigned Inventory tasks.

Task Description

Review Consumption Advices
 

Review inventory consumption advice details.
 

Manage Consigned Inventory Aging
 

Search, review, and maintain consigned inventory aging.
 

Review Consumption Advice Exceptions
 

Review inventory consumption advice exception details..
 

Create Transfer to Owned Transaction
 

Initiate an inventory transaction to transfer consigned inventory to owned inventory.
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Task Description

Transfers the ownership of the inventory from the supplier to the internal organization.
 

Create Transfer to Consigned Transaction
 

Initiate an inventory transaction to transfer owned inventory to consigned inventory.
 
Transfers ownership of the inventory from the internal organization to the supplier.
 

Use these guides to access content related to your inventory and consigned inventory tasks:

• Oracle Fusion Cloud SCM: Using Inventory Management

• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Counts
The Count tasks include both cycle counts and physical inventory.

This table shows the Cycle Count tasks.

Task Description

Create Cycle Counts
 

Create a count in which items are selected, counted, and reconciled with inventory records continually
throughout the year.
 

Manage Cycle Counts
 

Search, review, and maintain cycle count information.
 

Record Count Sequences
 

Enter the count quantity and recorded by for an individual item belonging to a cycle count.
 

Approve Count Sequences
 

Authorize an individual item count.
 

Review Count Interface Records
 

Review details of the count interface records.
 

This table shows the Physical Inventory tasks.

Task Description

Manage Physical Inventories
 

Search, review, and maintain physical inventories.
 

Record Physical Inventory Tags
 

Enter the count quantity for the physical inventory tags.
 

Approve Physical Inventory Adjustments
 

Authorize physical and financial inventory change.
 

Use these guides to access content related to your cycle count and physical inventory tasks:

• Oracle Fusion Cloud SCM: Using Inventory Management

3
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• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Shipments
This table shows the Shipments tasks.

Task Description

Manage Shipments
 

Search, review, pack, confirm and close shipments.
 

Manage Shipment Lines
 

Search, review, and maintain shipment lines.
 

Manage Shipment Message Interface
 

Review messages sent or received for a shipment or shipment line.
 

Create Pick Wave
 

Create a new pick wave.
 

Confirm Pick Slips
 

Enter details of picked material and confirm a pick slip.
 

Create Outbound Shipment Request
 

Publish an event with the necessary criteria to select and send shipment lines to the external system as
shipment requests.
 

Manage Shipping Transaction Corrections
in Spreadsheet
 

Review and edit the pending or unprocessed shipping transactions received through the open
interface.
 

Use the Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management guide to access content
related to your shipment tasks.

Picks
This table shows the Picks tasks.

Task Description

Create Pick Wave
 

Create a new pick wave.
 

Confirm Pick Slips
 

Enter details of picked material and confirm a pick slip.
 

Schedule Pick Wave
 

Create pick waves on a regular basis adhering to set of release criteria.
 

Create Outbound Shipment Request
 

Publish an event with the necessary criteria to select and send shipment lines to the external system as
shipment requests.
 

Use these guides to access content related to your pick tasks:

• Oracle Fusion Cloud SCM: Using Inventory Management

4
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• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Receipts
The Receipts tasks include expected shipments, receipts, unordered receipts, and returns.

This table shows the Expected Shipments tasks.

Task Description

Receive Expected Shipments
 

Search, review, and select shipment lines to receive.
 

Manage Inbound Shipments
 

Search, review, and select inbound shipments to modify.
 

Create ASN
 

Maintain and communicate the advanced shipment notice.
 

Create ASBN
 

Maintain and communicate the advanced shipment and billing notice.
 

Upload ASN or ASBN
 

Upload advanced shipment notices and advanced shipment and billing notices.
 

This table shows the Receipts tasks.

Task Description

Inspect Receipts
 

Search, review, and select receipt lines to inspect.
 

Put Away Receipts
 

Search, review, and select receipt lines to put away.
 

Correct Receipts
 

Search, review, and select receipts to correct.
 

Review Receipts Interface
 

Review the receipt transactions interface.
 

Quality Inspection Results
 

Search, review, and select receipts to view quality inspection results.
 

This table shows the Unordered Receipts tasks.

Task Description

Create Unordered Receipt Lines
 

Create individual receipt transactions that identify the receipt of an unordered item without reference
to a purchase order.
 

Match Unordered Receipts
 

Search, review, and select receipt lines to match.
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This table shows the Returns tasks.

Task Description

Return Receipts
 

Search, review, and select receipt lines to return.
 

Manage Supplier Returns Without Receipt
 

Create, edit, delete, and cancel supplier returns without a receipt.
 

Use these guides to access content related to your receipts tasks:

• Oracle Fusion Cloud SCM: Using Receiving

• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Related Topics
• Oracle Fusion Cloud SCM: Using Inventory Management

• Oracle Fusion Cloud SCM: Using Receiving

• Oracle Fusion Cloud SCM: Manufacturing and Supply Chain Materials Management

Inventory Management Work Area  
Oracle Fusion Cloud Inventory Management offers a complete materials management solution that enables companies
to manage the flow of inbound and outbound material within the warehouse and stocking locations.

Oracle Fusion Cloud Inventory Management is comprised of products designed for specific warehouse management
business processes and tasks throughout the Inventory, Shipping, and Receiving applications. The Inventory
Management work area provides a landing pad for these applications.

You can use the Inventory Management work area to view high-level details of your warehouse operations through
infolets. Also, access tasks and processes to perform from the Task panel of the Inventory Management work area.

To use the Inventory Management work area, you must be aware of these items:

• Access

• Navigation

• Infolets

• Tasks

Access
Your access to the Inventory Management work area is determined by these factors:

• The products that your enterprise has licensed and configured

• The security privileges and roles assigned to your user account

These factors determine which infolets and tasks you can view and access.

6
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For more information about inventory, shipping, and receiving roles and privileges, refer to the Oracle Fusion Cloud
SCM: Security Reference for Manufacturing and Supply Chain Materials Management guide.

Navigation
To access the Inventory Management work area, click Navigator > Supply Chain Execution >  Inventory Management.

Infolets
Infolets are visual, actionable, and personalized information cards summarizing critical data about specific objects.
Infolet cards display in the Inventory Management work area to make key performance indicators easy to view,
understand, and act upon. Use the infolets in the Inventory Management work area to quickly view details about picks,
cycle counts, on-hand values, shipments, and receipts.

You can do the following with infolet cards:

• Flip or expand the card to view additional details about the object featured in the infolet card.

• Drill down to more details by navigating to relevant manage pages from the infolet view.

• Hide infolet cards.

• Reorder infolet cards.

Use the My Infolets icon in the right corner of the Inventory Management work area to toggle your infolets on and off.
Drag and drop infolets to rearrange them in the work area.

This table describes the infolets available on the Inventory Management work area, along with the page that you can
drill into by clicking details in the infolet.

Infolet Description Drill Down Page

Picks
 

View the number of open or confirmed picks.
Toggle to view open picks by pick slip type.
 

Confirm Pick Slips page
 

Late Cycle Counts
 

View the number of late cycle counts. Expand
the page to view individual late counts and drill
down to examine them.
 

Record Count Sequences page
 

Cycle Count Sequences
 

View cycle count sequences to approve and
record. Drill down to perform the cycle count
approval and recording tasks.
 

Manage Count Sequences page
 

On-Hand Value
 

Expand and drill into the Manage Items
Quantities page to view on-hand availability
details for items.
 

Note:
If you have access to multiple organizations
and the organizations have different
currencies, this infolet doesn't display
any data. Instead a message of No data
available displays.
 

Manage Item Quantities page
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Infolet Description Drill Down Page

Open Shipments by Priority
 

View the number of open shipments by priority
levels. Drill down to view shipment details.
 

Edit Shipments page
 

Open Shipments by Carrier
 

View the number of open shipments by top
carriers. Drill down to view shipment details.
 

Manage Shipments page
 

Shipment Lines
 

View shipment line statuses presented in a
circle graph:
 

• Awaiting pick release

• Awaiting pick confirm

• Backordered

• Awaiting ship confirm

Toggle to the next screen to see a summary
of shipment lines past due and the amount of
time that's past due for the shipment lines:
 

• 0 to 3 days

• 4 to 7 days

• 8 to 14 days

• 15 to 30 days

Click a shipment line status to drill down to the
Manage Shipment Lines page.
 

Manage Shipment Lines page
 

Shipment Exceptions
 

View the number of shipment exceptions and
drill down to view details of the shipment
exceptions.
 

Edit Shipment page
 

Shipment Lines for Next 30 Days
 

View shipment lines expected in the next 30
days presented in a bar graph based on time:
 

• 1 to 3 days

• 4 to 7 days

• 8 to 14 days

• 15 to 30 days

Drill down to view details of the expected
shipments.
 

Manage Shipment Lines page
 

Receipt Lines
 

View receipt line statuses:
 

• Awaiting receipt

• Awaiting put away

• Awaiting inspection

Drill down to the Receive Expected Shipments,
 Inspect Receipts page, and Put Away Receipts
page accordingly.
 

Receive Expected Shipments, Put Away
Receipts, and Inspect Receipts pages
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Infolet Description Drill Down Page

Toggle to view receipt lines that are past due
and broken down by time past due:
 

• 0 to 3 days

• 4 to 7 days

• 8 to 14 days

• 15 to 30 days

Note:  You can choose to display data for
30 days or 7 days using the Date Range for
Inventory Management Infolets profile
option for the Awaiting Receipt portion of the
infolet. The default setup is 7 days. You can
change this to 30 days if required.

Expected Receipt Lines
 

View expected receipt lines due in these time
ranges:
 

• 1 to 3 days

• 4 to 7 days

• 8 to 14 days

• 15 to 30 days

Drill down to view details of the expected
shipments.
 

Note:  You can choose to display data for
30 days or 7 days using the Date Range for
Inventory Management Infolets profile
option. The default setup is 7 days. You can
change this to 30 days if required.

Receive Expected Shipments page
 

Inspected Receipts
 

View the number of inspected and rejected
receipt lines. Drill down to view details of these
inspected receipts.
 

Manage All Lines page
 

Receipt Exceptions
 

View the number of receipt exceptions and drill
down to view details of the receipt exceptions.
 

Manage All Lines page
 

Backordered Supply Lines
 

View the number of backordered supply lines in
these statuses:
 

• Awaiting receipt

• Awaiting inspection

• Awaiting put away

Drill down to the Receive Expected Shipments,
 Inspect Receipts, and Put Away Receipts pages
accordingly to view details of the backordered
supply lines.
 

Receive Expected Shipments, Inspect Receipts,
 and Put Away Receipts pages
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Infolet Description Drill Down Page

Note:  You can choose to display data for
30 days or 7 days using the Date Range for
Inventory Management Infolets profile
option for the Awaiting Receipt portion of the
infolet. The default setup is 7 days. You can
change this to 30 days if required.

Inventory Transactions
 

View the number of internal inventory
transaction line records not yet processed or
in error. You can view these pending lines by
transaction type when data is available:
 

• Miscellaneous issue

• Miscellaneous receipt

• Account alias issue

• Subinventory transfer

• Interorganization transfer

• Cycle count adjustment

• User-defined transaction

• Receipt from

• Invalid (records without organization ID or
transaction type ID defined)

Note:
When the number of transaction types for
the pie chart goes beyond 9, the category
of Other displays to include transaction line
records for those categories that go beyond
9.
 

You can't drill into any transaction pages from
this infolet.
 

Note:
This infolet applies to integrations with third
parties, such as warehouse management
systems and third-party logistics companies.
 

Shipments and Receipts
 

View the number of external inventory
transaction line records not yet processed or
in error. You can view these pending lines by
transaction type when data is available:
 

• Receipt confirmation - pending

• Receipt confirmation - error

• Receipt advice

• Shipment confirmation - ready

• Shipment confirmation - error

• Shipping request

You can't drill into any transaction pages from
this infolet.
 

Note:
This infolet applies to integrations with third
parties, such as warehouse management
systems and third-party logistics companies.
 

Inventory Balances
 

View a summary number of inventory
reconciliation transaction records. This infolet is
especially important to keep inventory balances

You can't drill into any transaction pages from
this infolet.
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Infolet Description Drill Down Page

accurate between your system and the external
system.
 

Note:
This infolet applies to integrations with third
parties, such as warehouse management
systems and third-party logistics companies.
 

Note:  An infolet legend label may not appear if no data exists for that label. For example, for the Expected Receipt
Lines infolet, if all receipt lines are expected within the next 7 days, then only these labels display:

• 1 to 3 days

• 4 to 7 days

The labels for 8 to 14 days and 15-30 days don't appear in this example since all receipt lines are expected within the
next 7 days.

Note:  You can then hide the seeded infolets displayed on the landing page of the Inventory Management work area.
See How You Hide Inventory Management Infolets in the Implementing Manufacturing and Supply Chain Materials
Management guide.

Tasks
Use the task panel of the Inventory Management work area to access tasks and processes related to these areas:

• Inventory

• Counts

• Shipments

• Picks

• Receipts

Switch between these main areas by selecting Show Tasks in the Task pane.

Related Topics
• Overview of Tasks from the Inventory Management Work Area

• How You Use and Personalize Infolets in Oracle Fusion Cloud SCM and Procurement

• Overview of Infolets

High-Level Tasks and Roles for Receiving  
Here are the high-level tasks for roles in Oracle Receiving.

11

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=u30240296
https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20056172
https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20074337


Oracle Fusion Cloud SCM
Using Receiving

Chapter 1
Overview

Receiving Agent
Receiving agent tasks can include:

• Purchase inventory

• Receive load

• Manage invoices

• Inspect material

• Disposition returns

• Manage supplier returns

Warehouse Operator
Warehouse operator tasks can include:

• Put away

Requester, Prepare, On Behalf
Requester, Prepare, On Behalf tasks can include:

• Manage receipts

• Manage receipt accounting

For more information about receiving roles, duties, and privileges, refer to the Oracle Fusion Cloud SCM: Security
Reference for Manufacturing and Supply Chain Materials Management guide.

FAQs for Receiving Roles  

How can I provide a user with a view-only role in Receiving?  
You can create custom job roles to view certain information within Inventory, Receiving, and Shipping. Additionally, you
can use Oracle Page Composer to hide specific fields and actions on selected user interfaces. Lastly, you can use Oracle
Transactional Business Intelligence (OTBI) to create reports and analytics with drill-down capabilities to view transaction
details.

For more information, see these guides:

• Oracle Fusion Cloud SCM: Creating and Administering Analytics and Reports for SCM

• Oracle Fusion Cloud SCM: Securing SCM

• Oracle Fusion Cloud Applications: Configuring and Extending Applications

12
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2  Manage Inbound Shipments

Overview of Managing Inbound Shipments  
In this activity, receiving agents and warehouse managers can edit or cancel shipments.

Inbound shipments include:

• ASNs (advance shipment notices) and ASBNs (advance shipment billing notices) from suppliers

• In-transit shipments from another inventory organization

• Transfer order shipments

Receiving agents and warehouse managers can select an individual shipment to be transferred to the Edit Shipment
page, where they can work on all shipment lines in a shipment at one time, or drill down into a specific shipment line on
the Edit Shipment Details page.

They can:

• Search for all three types of inbound shipments

• View or edit inbound shipments

• View or edit inbound shipment lines

• Cancel ASN and ASBN lines

• Cancel ASNs and ASBNs

To manage inbound shipments, select Navigator > Supply Chain Execution > Inventory Management. Select
Receipts from the task pane, and click Manage Inbound Shipments.

Cancellation of Inbound Shipments  
You can cancel inbound shipment lines or entire inbound shipments prior to receiving the material into the warehouse.

Important points to consider when canceling inbound shipments include:

• Lines eligible for cancellation

• Cancellation of the entire shipment versus cancellation of shipment line

• Ramifications of canceling an inbound shipment

Lines Eligible for Cancellation
You can only cancel ASN or ASBN lines that haven't been fully received up to the ordered quantity. In-transit shipment
lines, transfer order shipment lines, and fully received lines can't be canceled.
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Cancellation of the Entire Shipment Versus Cancellation of Shipment Line
You can cancel one or more lines of a shipment, or you can cancel the entire shipment. If you cancel all lines on a
shipment, the entire shipment is canceled.

Ramifications of Canceling an Inbound Shipment
If you cancel an ASN or ASBN line, it won't be available for receiving against the shipment. If you cancel the ASN or
ASBN, the entire shipment won't be available for receiving. Once a shipment is canceled, it can't be queried from the
Manage Inbound Shipments page.

FAQs for Inbound Shipments  

Why can't I cancel an inbound shipment or shipment line?  
You can't cancel an inbound shipment or shipment line in these scenarios:

• If the current line is an ASN or ASBN, and it's been fully received up to the ordered quantity

• If the current line is an in-transit shipment line or transfer order shipment line

What's the difference between inbound shipments and outbound
shipments?  
Inbound shipments are items that you receive into the warehouse. Oracle Receiving supports the receipt of purchase
orders, purchase requisitions, return material authorizations, and interorganization shipments.

Outbound shipments are items that you ship out of the warehouse. Oracle Shipping automates and helps manage
outbound shipments.

How can I receive inbound shipments using ASNs that a supplier
creates in the WMS?  
When a supplier creates advance shipment notices (ASNs), they are forwarded to the warehouse management system
(WMS) if Oracle Integration Cloud Service (ICS) integration is enabled.
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3  Receive Expected Shipment Lines

Receipt Creation  
Creating receipts is the process of recording goods that have arrived at the distribution center into the warehouse
system. Creating receipts is also known as receiving shipment lines.

These aspects are important when receiving shipment lines:

• New receipt or existing receipt

• Quantity and date tolerances

• Packing units, subinventories, and locators

• Receipt routing

• Multiple distributions

• Lot and serial number information

• E-signatures for approval

New Receipt or Existing Receipt
You can create a new receipt or add the items from the shipment to an existing receipt. If you create a new receipt, you
access the Create Receipt page to enter the receipt header details. If you add the items to an existing receipt, you access
the Add to Receipt page to select the receipt number.

Quantity and Date Tolerances
Oracle Receiving performs checks against the quantity and date when receiving items.

These checks include:

• Overreceipt tolerance

The maximum acceptable percentage of quantity that can be received in excess of the order quantity. Your
organization indicates the overreceipt tolerance and whether to prohibit the transaction, display a warning
message while permitting the transaction, or permit the transaction without a warning,

• Early and late receipt tolerance

The number of calendar days before and after the shipment delivery date that you allow receipt. Your
organization indicates the early and late receipt tolerances and whether to prohibit the transaction, display a
warning message while permitting the transaction, or permit the transaction without a warning.

Note:  The warehouse manager can edit the quantity and date tolerances on the Manage Receiving Parameters page.
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Packing Units, Subinventories, and Locators
Many distribution centers have a large receiving area that's divided into many subinventories and locators. These
distribution centers also store received material in containers known as packing units. When creating the receipt, you
can optionally enter packing unit, subinventory, and locator information.

Receipt Routing
When you receive a shipment line with direct receipt routing, items are put away automatically upon receipt creation.

For all other routing methods, you must manually put away the received items.

Multiple Distributions
When a purchase order schedule contains multiple distributions and the receipt routing is set to direct delivery, the
destination type defaults to Multiple. You receive at the distribution level if the receipt routing is direct delivery. You
receive at the schedule level if the receipt routing is standard or inspection required. To expand the line and show all
distributions, select the Show All Distributions item from the Actions menu of the Receive Lines and Receive Line
pages.

For requisition-sourced transfer order lines that use direct receipt routing, select the Show All Distributions item from
the Actions menu to obtain the transfer order distributions and populate the receipt quantity for each distribution
line. You can enter receipt quantities at the distribution level and the quantities for each distribution line are validated
against the associated transfer order distribution quantity.

Note:  In addition to the Show All Distributions option, you can edit the line with multiple distributions by changing
the destination type from Multiple to Receiving.

Lot and Serial Number Information
If you select a line to receive and the corresponding item is either lot or serial controlled, then you must enter the lot and
serial information. If the complete receipt line corresponds to a single lot or serial range, then you can update the lot and
serial information directly on the Receive Lines page or the Receive Line page. If not, then you can select the Record
Lots and Serial Numbers item from the Actions menu to enter new lots and serial numbers.

When executing a receipt with a receipt routing of direct delivery, you can default lot and serial numbers that were
previously entered on an advance shipment notice (ASN) or advance shipment billing notice (ASBN). This can increase
your efficiency (especially for high volumes) and reduce errors when receiving lot and serial-controlled items.

Use the Record Lots and Serial Numbers page to view and select lot and serial numbers that were entered on an ASN or
ASBN against the purchase order schedule. On the Record Lots and Serial Numbers page, click the Select ASN Lots or
Select ASN Serial Numbers buttons to view the lots and serial numbers from the associated ASN or ASBN. After you
make your lot and serial number selections, you return automatically to the Record Lots and Serial Numbers page where
you can now make corrections such as delete, add, or override to the lot and serial numbers, if desired.
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Note:
• For lot-controlled, dual UOM items, the secondary quantity and UOM display on the Select ASN Lots page.

• The Select ASN Lots and Select ASN Serial Numbers buttons on the Record Lot and Serial Numbers page are
enabled for lot and serial-controlled items respectively, when an ASN or ASBN exists against the purchase order
schedule. The ASN or ASBN also has to have lots or serial numbers entered. For example, if an ASN exists, but
there are no lots or serial numbers, the buttons aren't enabled.

Alternatively, on the Receive Lines and Receive Line pages, you can select the Default Lots and Serial Numbers from
ASN check box to accept all the lot and serial numbers entered on the ASN or ASBN without going to the Record Lots
and Serial Numbers page. The Default Lots and Serial Numbers from ASN check box isn't visible by default on these
pages. Add it by selecting the option from the View menu.

The Default Lots and Serial Numbers from ASN check box is available for selection only if these conditions apply:

• You've previously enabled the Allow defaulting of lots and serial numbers from ASN option on the Manage
Receiving Parameters page.

• The item is lot controlled, serial controlled, or both.

• An ASN or ASBN exists for the purchase order schedule.

• The receipt quantity is equal to the shipped quantity against the ASN line.

• Lot and serial information was entered while creating an ASN.

E-Signatures for Approval
If receipt transactions are configured for approval using e-signatures, the E-Signatures page opens when you create a
receipt and click Submit. Use the page to approve the transaction.

An e-signature is captured when creating a receipt for a document whose receipt routing is Direct Delivery. If the routing
is Standard or Inspection Required, then the e-signature isn't captured. For these routings, the e-signature is captured
during a put away.

The e-signature IDs are recorded and available from the Manage All Lines and Transaction History pages.

For information about e-signatures, see the Oracle Fusion Cloud SCM: Using E-Signatures and E-Records guide,
available on the Oracle Help Center.

For information about how to configure e-signatures for supply chain management transactions, see the Oracle Fusion
Cloud SCM: Implementing Manufacturing and Supply Chain Materials Management guide, available on the Oracle Help
Center.

Receipt Routing  
Oracle Receiving supports the receipt of purchase orders, return material authorizations (RMAs), and interorganization
shipments in each of three receipt routing methods.
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These receipt routing methods include:

• Direct delivery

• Standard receipt

• Inspection required

You can override the receipt routing option at receipt time by changing the destination type for specific suppliers, items,
and orders if the receiving user profile for the Allow Routing Override option is enabled.

Direct Delivery
Shipments are received into a receiving location and put away in the same transaction. Put away happens automatically
upon receipt creation.

Standard Receipt
Shipments are received into a receiving location and then put away in a separate transaction. Standard receipts can be
inspected or transferred before put away.

Inspection Required
Shipments are received into a receiving location and then inspected and put away in separate transactions. You can
accept or reject material during the inspection, and put away to separate locations, based on the inspection result.

Capture Lot and Serial Numbers for Expense Destination
Receipts  
You can capture lot or serial numbers for expense destination receipts.

You can capture a good’s lot or serial number information for items that are lot and serial number enabled for expense
destination receipts during put away for standard and inspection-based receipts or during receipt for direct delivery
receipts in warehouse receiving. You may enter the lot and serial numbers on the Receive Lines and Put Away Lines
pages for purchase orders and transfer orders. You can also correct receipts for expense destination purchase orders
with specific lot and serial numbers when you want to return quantities of items that you procured. In such cases, it’s
recommended that you specify the lot and serial number for each returned quantity. You can view the captured lot and
serial numbers on the View Transaction History page.

If an asset is enabled for asset tracking and product genealogy, then the information passes to Oracle Fusion Cloud
Installed Base to create assets.
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Note:
• You can capture lot and serial numbers for expense destination receipts, returns, or corrections using

Receiving, but not using Self-Service Receipts.

• Lot and serial numbers can't be captured for ASNs in expense destination receipts.

• Expense destination receipts for one-time addresses for lot and serial-controlled items aren't supported.

• Material status isn't applicable for lots and serial numbers received for expense destination receipts.

• On-hand inventory balances aren't maintained for items in expense destination receipts.

• You can't perform inventory transactions on serial numbers received for expense destination receipts.

• Oracle Inventory Management assigns Issued out of stores as the usage for serial numbers received for
expense destination receipts.

Related Topics
• Overview of Lot Control

• Overview of Serial Number Control

• How You Manage Assets in the User Interface

Capture Lot and Serial Numbers for Work Order
Destination Receipts  
You can capture lot or serial numbers for work order destination receipts.

When procuring goods for a specific work order, there are instances when you want to capture the lot and serial
information for those goods. For example, when repairing a piece of asset equipment that requires a component to be
replaced, if the component is serialized and the equipment you are repairing is asset tracked, then you must capture
the component’s serial number to ensure the asset hierarchy is updated to reflect the replacement. In such cases, you
submit a purchase requisition to indicate that the goods are specific for the work order to perform the repairs. You can
capture a good’s lot or serial number information for work order destination receipts during put away for standard
and inspection-based receipts or during receipt for direct delivery receipts in warehouse receiving. The information is
passed to Oracle Fusion Cloud Installed Base if the item is enabled for asset tracking and product genealogy if the item
is enabled for genealogy tracking.

You can capture lot and serial information for lot and serial-controlled items for work order destination receipts in real
time and automatically associate that data with the respective installed base and genealogy records for more accurate,
seamless, and efficient asset tracking. This provides easy maintenance of assets based on lot and serial numbers.
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Note:
• You can capture lot and serial numbers for work order destination receipts with Receiving, but not through Self-

Service Receiving.

• ASNs for work order destination purchase orders aren't enabled for capturing lot and serial numbers.

• On-hand inventory balances aren't maintained for work order destination receipts and these lot and serial
numbers aren't visible on the Manage Item Quantities page.

• Oracle Inventory Management assigns Issued out of stores as the usage for lot and serial numbers for work
order destination receipts.

• Work order destination receipts for one-time addresses for purchase orders for lot and serial items aren't
supported.

• You can't return or correct outside processing purchase orders on Receiving pages. Use the Manufacturing and
Maintenance pages, instead.

• Material status functionality isn't applicable for lot and serial numbers received using work order destination
receipts.

Related Topics
• Overview of Lot Control

• Overview of Serial Number Control

• Overview of Work Orders

• How You Manage Assets in the User Interface

Parent and Child Receiving Transactions  
Use the Transaction History page to view an item's transaction history as if it were a family tree with parent and child
transactions.

From the time of receipt, many transactions may be required to record the movement of an item through the receiving
and inspection process. For example, after being received, you can transfer, inspect, and then put away an item. You can
keep track of an item since these transactions are linked together.

These aspects are important regarding parent and child relationships for receiving transactions:

• Parent and child relationship conditions
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• Parent and child relationship example

• Transaction history

Parent and Child Relationship Conditions
A parent transaction can have one or more child transactions, but a child transaction has only one parent transaction.

Parent and Child Relationship Example
A receipt is received and then transferred. The receipt transaction is the parent of the transfer transaction, while the
transfer transaction is the child of the receipt transaction.

Transaction History
The Transaction History page displays parent transaction information to help you determine the status of the item for
which you're entering a transaction. For example, if you're about to transfer an item from Receiving Dock 1 to Inspection
Area A, you can verify that the parent transaction's location is Receiving Dock 1. The Transaction History page also
displays the parent transaction's unit of measure (UOM) and available quantity. The Transaction History page shows the
individual transaction quantities in transaction UOMs. This is particularly helpful for receipts with inspection, put away,
and return transactions in different UOMs since the Receipt (Summary) page shows the quantities in an item's primary
UOM. The available quantity is significant because you can't enter a quantity for a current transaction that's greater than
the parent transaction's available quantity. For example, if you have received 10, you can inspect only up to a quantity
of 10. The Transaction History page also displays the inspection result for a parent transaction if the given material has
been accepted or rejected as part of an inspection.

Receiving Transaction History  
Receiving transactions take place in different units of measure (UOM). For example, this table shows the transaction
units of measure that we have for a particular item:

UOM Type UOM Unit

Purchase order created in item UOM
 

Dozen
 

Receiving item UOM
 

Dozen
 

Return item UOM
 

Each
 

Because you can order items in one unit of measure, and receive, inspect, put away, and return the items in a different
unit of measure, Receiving always shows data in an item's primary unit of measure on the Receipts page. However,
you can use the Transaction History page to view the quantities in transaction UOMs for the individual transactions
performed.

To access the Transaction History page, you must first navigate to the Receipt page for a particular receipt. Click the
receipt number link from the following pages, such as Put Away Receipts, Inspect Receipts, Return Receipts, and Correct
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Receipts to access the Receipt (Summary) page. On the Receipt (Summary) page, select the View Transactions History
button.

Receipt Creation With Consignment Lines  
You can create new receipts with consigned items, add consigned items to existing receipts, and receive advanced
shipment notices (ASNs) with purchase order lines that are for consigned items.

Consignment lines are receipt lines containing items that are in the possession of one party, but remain the property of
another party.

These aspects are important when receiving shipment lines with consigned items:

• Consignment line indicator

• Quantity and date tolerances

• Interface to Oracle Cost Management

• In-transit shipments

Consignment Line Indicator
If a receipt line is for a purchase order containing consigned items, the page displays the Consignment Line check box
as selected for that line. To make the Consignment Line check box visible on the page, select the field from the View >
Columns menu.

Quantity and Date Tolerances
Oracle Receiving performs the same checks against the quantity and date when receiving consigned items as it does for
receiving owned items.

These checks include:

• Overreceipt tolerance: The maximum acceptable percentage of quantity that can be received in excess of the
order quantity. Your organization indicates the overreceipt tolerance and whether to prohibit the transaction,
display a warning message while permitting the transaction, or permit the transaction without a warning.

• Early and late receipt tolerance: The number of calendar days before and after the shipment delivery date that
you allow receipt. Your organization indicates the early and late receipt tolerances and whether to prohibit the
transaction, display a warning message while permitting the transaction, or permit the transaction without a
warning.

Note:  You can edit the quantity and date tolerances on the Manage Receiving Parameters page.

Interface to Oracle Cost Management
Consigned items aren't accrued at receipt. Receiving interfaces the received consigned items to Cost Management. Cost
Management then identifies the transactions for consigned items, but doesn't cost the transactions. The owning party
remains the supplier.
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In-Transit Shipments
When you receive items for in-transit shipments, the material remains consigned and the aging period isn't reset. The
aging period is based on the receipt date at the organization where the material was received by the buyer against the
purchase order.

Related Topics
• Receipt Creation

• Consigned Inventory

How You Receive Transfer Orders from Requisition Lines 

If receiving is required upon shipping a transfer order sourced from a requisition, there are several ways to receive the
item.

• Use the self-service receiving pages to receive transfer orders by the preparer of the associated requisition.

If multiple accounting distributions exist on a transfer order line, then receiving transactions are performed at
the distribution level. To use the self-service receiving pages for transfer orders, the receipt routing must be set
to Direct routing.

• Use the receiving pages to receive requisition-sourced transfer orders.

You can enter receipts and put away transactions for individual accounting distribution line quantities
associated with a transfer order line.

• Load receiving transactions from external sources using the Receiving Receipt Import template.

FAQs for Creating Receipts  

What happens if I am receiving lines that are lot or serial
controlled?  
You must specify lot numbers and serial numbers.

You can enter the applicable lot and serial numbers directly into the table. Or, select the Record Lots and Serial
Numbers item from the Actions menu on the Receive Lines page to record the applicable lot and serial numbers.

Note:  The option to specify lot and serial numbers is applicable to receipt lines with direct receipt routing only. For
receipt lines with a receipt routing of standard or inspection required, you enter the lot and serial numbers during put
away.
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How can I receive closed purchase orders?  
You must select the option to include closed purchase orders on both the Manage Receiving Parameters page and the
Receive Expected Shipments page.

To access this check box on the Receive Expected Shipments page, select the Add Fields button and then select the
Include closed purchase orders item from the list of fields.

Why can't I populate the receipt quantity for my received lines?  
The option to enforce blind receiving was selected for the organization on the Manage Receiving Parameters page. With
blind receiving, you cannot view the quantity due or the quantity ordered for shipments when you receive items.

What's the difference between the Create Receipt and Add to
Receipt options when creating a receipt?  
Select Create Receipt to create a new receipt for the lines. You can record the receipt number manually or let the
application create a receipt number based on the value of the receipt number Generation parameter previously set up.

Select Add to Receipt to add receipt lines to an existing receipt number. You can select the receipt from a list of
previously received receipts.

With both the Create Receipt and Add to Receipt options, you can update all attributes on the receipt header except
for the supplier or customer. You can enter shipment-related information such as shipment, packing slip, shipping
method, shipped date, waybill, and bill of lading.

Can I enter a receipt number when creating a new receipt?  
Your ability to enter the receipt number when creating a new receipt depends on the setting of the receipt number
Generation parameter specified on the Manage Receiving Parameters page.

If the receipt number Generation parameter is set to Automatic, then you can't enter a receipt number when creating
a receipt. The application creates the receipt number for you. However, if you set the receipt number Generation
parameter to Manual, you can enter a receipt number when creating a receipt.

How can I search for consignment-only lines?  
Add the Consignment Line check box to the search criteria by selecting the field from the Add Fields option. Then,
select the Consignment Lines check box as part of your search criteria.

24



Oracle Fusion Cloud SCM
Using Receiving

Chapter 3
Receive Expected Shipment Lines

How can I determine if a receipt line is a consignment line?  
Add the Consignment Line check box to the page by selecting the field from View menu. Use View > Columns. If the
Consignment Line check box is already selected, that indicates that the receipt line is a consignment line.

Can I add consigned items to an existing receipt?  
Yes, you can add consigned items to an existing receipt.

Can I receive ASNs and ASBNs for purchase orders with consigned
items?  
You can receive ASNs for purchase orders with consigned items. However, you can't receive purchase orders for ASBNs
with consigned items.

What are tax determinants?  
Explicitly or implicitly available details on transactions such as receipt, ship confirm, and consumption that become
inputs into the tax determination process. The tax determination process calculates the applicable taxes on the
transaction.

Examples of tax determinants are Taxation County, Product Fiscal Control, and Tax Classification Code.

Why can't I edit the tax determinants?  
You must provide a value for the Taxation Country attribute before you can edit the following fields:

• Transaction Business Category

• Document Fiscal Classification

• User-Defined Fiscal Classification

• Product Fiscal Classification

• Intended Use

• Product Category

Also, some shipment and receiving lines don't show tax determinants due to their line status.

25



Oracle Fusion Cloud SCM
Using Receiving

Chapter 3
Receive Expected Shipment Lines

What happens when I receive items configured for serial number
entry at pick?  
You don't need to enter the serial number if the received item is configured for serial number entry at pick.

How can I export receiving transaction history?  
You can export completed receiving transactions to Excel from the Transactions History page. Select Export to Excel
from the Actions menu or click the Export to Excel table icon.

What's the difference between the receipt date at the receipt line
and receipt header level?  
The application uses the receipt date at the line level (Receive Lines or Receive Line pages) for accounting and invoicing
purposes. This becomes the receipt's transaction date. Receipt Accounting, Payables, and Cost Management use this
date.

The receipt date at the header level (Create Receipt or Add to Receipt pages) may be used for analytics in the future.

You must capture both receipt dates when creating receipts in the UI. The receipt dates at the receipt header and receipt
line level both default to the current date. The GL Date on the Create Receipt and Add to Receipt pages also defaults
to the current date. You can change all of these dates. However, it's the receipt date at the line level that's used for
accounting and invoicing.

Can I enter a past date for receiving transactions?  
Yes, you can enter a past date for a receive, inspect, put away, correct, or return transaction when the Transaction Date
Validation Enabled inventory profile option is set to No validation.

Also, the value of the Maximum Number of Days Prior to Current Date in Which a Transaction Can Be Created
inventory profile option (for inventory and work order destination transactions) must be within your threshold.

The Maximum Number of Days Prior to Current Date in Which an Expense Destination Transaction Can Be
Created receiving profile option can be set for expense destination transactions, and it works irrespective of the setting
for the Transaction Date Enabled inventory profile option.
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How can I view the manufacturer part number when receiving
goods?  
To display the manufacturer part number (MPN) and manufacturer name when receiving goods and performing
associated transactions, you must enable the columns from the View menu throughout the Receiving and Self-Service
Receiving pages.

Select View > Columns > Manufacturer Part Number and View > Columns > Manufacturer.

If there is a single value for the MPN and manufacturer against the record, the values display directly in the record.
However, if there are multiple values for the MPN and manufacturer, you see a Multiple link display in both columns.
Click either the value or the Multiple link to open the Manufacturer Parts window to view the full list of MPNs and
manufacturers.

Note:  If the source document line is a PO line, the application sources the MPN and manufacturer from the PO line
itself. If the source document line isn't a PO line, the application sources the MPN and manufacturer from the item
master record in Oracle Product Hub.

How can I view packing slip details when receiving a purchase
order with an ASN or ASBN?  
When receiving an ASN or ASBN, both the header and line packing slip details don't display on the Receive Expected
Shipments page. You must click the ASN or ASBN number to view the packing slip details.

The value that you entered for the packing slip at the ASN header level does default at the receipt header level when
receiving material using an ASN.

Why can't I search for requisition numbers on the Receive
Expected Shipments page?  
The Receive Expected Shipments page is designed for the receiving agent in the warehouse. The backing documents
for those receipts are typically purchase orders or advanced shipment notices. The Self-Service Receiving UI is designed
for users to receive against a requisition number.

Why did I get a quantity tolerance error when receiving a purchase
order, sales order, or work order?  
If you have zero quantity tolerance set for the purchase order schedule, you can sometimes get a quantity mismatch
due to the setting of the INV_QUANTITY_DECIMAL_PRECISION profile option.
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The quantity on the purchase order, sales order, or work order uses the decimal precision set for the
INV_QUANTITY_DECIMAL_PRECISION profile option for rounding purposes. Received quantity rounds off based
on the value of this profile option when a quantity with a higher decimal precision is entered that's supported by the
profile, or when converting between two units of measure. Decimal precision refers to the number of digits placed
after the decimal point when truncating the calculated value of a quantity in another unit. For example, let's say the
ordered quantity is 20.12345 on the purchase order. When the INV_QUANTITY_DECIMAL_PRECISON profile option is
set to 2 and you enter the received quantity as 20.12345, the application rounds off the received quantity to 20.12. The
remaining quantity of 0.02 remains open on the purchase order. When the decision precision is set to 5, you can receive
the exact quantity.

To set the INV_QUANTITY_DECIMAL_PRECISION profile option use the Manage Units of Measure Profiles task from
the Setup and Maintenance work area:

• Offering: Manufacturing and Supply Chain Materials Management

• Functional Area: Items (click Show All Tasks)

• Task: Manage Units of Measure Profiles

On the Manage Units of Measure Profiles page search for the INV_QUANTITY_DECIMAL_PRECISION profile option.
The default value for the Profile Value field is 5. You can change this value.

What's the difference between the Shipment field on the Create
Receipt page and the ShipmentNumber attribute in the Receiving
Receipt Requests REST resource?  
When receiving expected shipments, you can enter any value in the Shipment field on the Create Receipts page. This is
a free text field.

The same isn't true about the ShipmentNumber attribute in the REST API. When the ShipmentNumber attribute is
populated in the Receiving Receipt Requests REST resource, the value is treated as the ASN shipment number. There's
no equivalent free text shipment field in the REST API.
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4  Inspect Receipts

Receipt Line Inspections  
Inspection is the process of accepting or rejecting goods from suppliers or customers before they're put away to their
final destination.

These aspects are important when inspecting receipt lines:

• Inspection quality

• Inspection quantity

• Split line inspections

• Multiple or single line inspections

• Packing units

• Inspection example

Inspection Quality
Quality codes indicate a particular quality standard. For example, Excellent Condition or Damaged are good examples
of quality codes. You define quality codes during setup and your company can define as many codes for inspection as
you want. Each code must have a corresponding number ranking, which provides an inspection scale. You use these
inspection codes when you receive and inspect the items you ordered.

Inspection Quantity
The inspection quantity field defaults to the receipt quantity. Accept the default quantity if you're accepting or rejecting
all items. If you choose to partially accept or reject a line, you can edit the quantity.

Split Line Inspections
You can split a receipt line prior to inspection.

Splitting a receipt line enables you to:

• Store the receipt line items in two different packing units after inspection.

• Partially accept and reject the line.
For example, if you have a quantity of 10 items, you can split the line and then accept a quantity of 5 items and
reject a quantity of 5 items.

• Provide a different quality code for quantities belonging to a single receipt.

Multiple or Single Line Inspections
You can choose to accept or reject multiple lines on a receipt at one time, or inspect the lines individually. Use the
Inspect Receipt Lines page to inspect multiple lines at one time. Use the Inspect Receipt Line page to inspect only one
receipt line.
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Packing Units
You can enter the transfer packing unit number if material is kept inside a packing unit after inspection.

If the material is kept inside a packing unit after receipt and before inspection, then that's shown as the Source Packing
Unit on the Inspect Lines and Inspect Line pages.

Oracle Receiving defaults the source packing unit value to the Transfer Packing Unit field. However, the transfer
packing unit number can be the same as the source packing unit number only if the entire quantity is either being
accepted or rejected.

Inspection Example
At the receiving dock, you receive a shipment of 200 glass vials that require inspection. You record receipt and send
the items to inspection. As the inspector of the 200 glass vials, you want to accept 195 and reject 5. You split the line
into two lines so that you can send the 5 rejected glass vials back to the supplier and deliver the 195 glass vials to the
requester.

Record Inspection Results  
You can use the Receipts task in Inventory Management to measure supplier quality during receiving. You can also
measure manufacturer quality during inspection for in-house manufacturing or contract manufacturing.

In the example in this topic, you record that you received and inspected a quantity of 2 for item AS54888, color blue,
from receipt 33492, in organization M1 Seattle Manufacturing, from supplier Computer Service and Rentals.

This topic includes example values. You might use different values, depending on your business requirements.

Summary of the Work

Record inspection results:

1. Create the receipt.
2. Record your inspection results.

Create the Receipt
Create the receipt:

You are going to first take physical receipt of the item. Then, you can inspect the item contents and qualities, such as
quantity, according to your company quality requirements. For this example, assume you received a quantity of 2 for
item AS54888.

1. In the Navigator, click Supply Chain Execution, and then click Inventory Management.
2. Click Receipts in the task pane.
3. In the Select Organization dialog, set the value as shown in the following table, and then click OK.

Attribute Value

Organization
 

M1
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If the Select Organization dialog doesn't display, then, on the Overview page, click Change Organization.
4. On the Overview page, notice that you can use different ways to record a receipt, depending on the details that

are available to you.

For example, if you have the purchase order number, then you can click Search, set the Document Type to
Purchase Order, and then enter the purchase order number in the Document Number window.

For this example, assume the Supplied By tab on the Overview page displays the row shown in the following
table.

Supplied By Expected Shipment Lines

Computer Service and Rentals
 

1
 

Click the link in the Expected Lines Shipment column for Computer Service and Rentals.
5. On the Receive Expected Shipments page, click the row that contains the values in the following table, and then

click Receive.

Organization Item Line Status Receipt Quantity

M1
 

AS54888
 

Received
 

33492
 

2
 

6. On the Receive Lines page, enter the value shown in the following table for the Quantity field, and then click
Create Receipt.

Attribute Value

Quantity
 

2
 

7. On the Create Receipt page, add any other details that your company uses to verify the receipt, and then click
Submit.

8. In the Confirmation dialog, notice the receipt number, such as 34071, and the number of lines, such as 1, click
OK, and then click Done.

Record Your Inspection Results
Record your inspection results:

1. On the Overview page, click Tasks, and then click Inspect Receipts.
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2. On the Inspect Receipts page, in the Search area, enter the value shown in the following table for the Receipt
field, and then click Search.

Attribute Value

Receipt
 

33492
 

3. In the Search Results, click the row that includes 33492 in the Receipt column, and then click Inspect.
4. On the Inspect Lines page, click the row that includes 33492 in the Receipt column, and then click Enter

Quality Results.
5. On the Inspect page, notice that you can use the following display to specify the results of different samples

inspected when you performed the physical inspection.

The following figure shows the Inspect page.

This table shows the attributes displayed on the Inspect page.

Attribute Value

Inspection Plan
 

Defines the data you must collect.
 

Samples
 

A representative part of a larger group that you inspect and use as evidence of quality.
 
For example, assume you received 500 units of item AS54888. In most situations, it isn't
feasible to perform a thorough inspection of every unit, particularly when a large quantity
is involved. Instead, you can inspect one or more samples of the quantity, and then use the
Inspect page to record your observations.
 
Your Quality Engineer sets up the inspection plan so it displays the number of samples you
must record, and the characteristics you must measure.
 

Inspection Level
 

Indicates the percentage of units you must inspect. For example:
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Attribute Value

◦ 100%. You must physically inspect 100% of the number of units you received, and record
the inspection result for each unit. For example, if you receive 100 units, then you must
physically inspect each of the 100 units, and record 100 inspections results.

◦ 10%. You must physically inspect 10% of the number of units you received. For example, if
you receive 100 units, then you must physically inspect 10 units, and record 10 inspection
results.

 

Characteristic
 

Properties, measurements, or tests you use to measure item quality.
 

Status
 

The status area contains the following values:
 

◦ Samples. Total number of samples you must record.

◦ Pending. Number of samples you haven't yet recorded.

◦ Accepted. Number of samples you recorded where the Result matches the Specification.

◦ Rejected. Number of samples you recorded where the Result doesn't match the
Specification.

Sequence
 

Determines the sequence to use when you inspect the characteristic. For example, if the
Sequence for characteristic color is 10, and if the Sequence for characteristic size is 20, then you
must record the color first, and then the size.
 

For this example, assume your Quality Engineer set up item AS54888 from supplier Computer Service and
Rentals so that you must perform a 100% inspection, but measure only the Blue specification.

6. In the Samples area, click 33492-1.
7. In the Inspection Results area, set the value for the Result field as shown in the following table.

Attribute Value

Result
 

Blue
 

Notice that the value for Pending changes from 2 to 1, and Accepted changes from 0 to 1.
8. In the Samples area, click 33492-2.

In the Inspection Results area, set the value for the Result field as shown in the following table.

Attribute Value

Result
 

Blue
 

Notice that the value for Pending changes from 1 to 0, Accepted changes from 1 to 2, and Disposition changes
to Complete.

9. Click Save and Close.
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10. On the Inspect Lines page, click Submit, and then click OK.

The Inspect Lines page submits the inspection line result to Warehouse Operations.
11. On the Overview page, click Tasks, and then click Quality Inspection Results.
12. On the Quality Inspection Results page, search for AS54888, and then examine the results.

Notice the results display each inspection that includes item AS54888, sorted according to supplier. You can
use Quality Inspection Results to help manage the items, suppliers, and other details that you have or haven't
inspected.

Using the Inspect Lines Page

Note that the Inspect Lines page might display different values for items, depending on how your Quality Engineer sets
up the inspection plan.

This table shows how the inspection plan could appear depending on your setup, and what options you have for
entering quality results.

Inspection Plan Description

Plan is available and requires you to
perform quality inspection
 

You must click Enter Quality Results.
 

Plan is available and you can you skip
Quality Inspection
 

Skip Quality Inspection contains a check mark. You can remove this check mark, and then click Enter
Quality Results as option.
 

Plan isn't available
 

You must click Remove Line.
 

Related Topics
• Receipt Line Inspections

FAQs for Inspect Material  

How can I reinspect already inspected lines?  
Prior to performing your search, select the Include lines already inspected item from the Add Fields menu. Select the
Include lines already inspected check box and perform your search. The search results show lines that have been
inspected, but not yet put away.
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5  Put Away Receipts

Put Aways  
Putting away received lines is the process by which goods are moved to their final destination.

These aspects are important when putting away received lines:

• Lot and serial number information

• Inventory or expense destinations

• Packing units

• Multiple distributions

• Receipt line transfer

• Split lines

• E-signatures for approval

Note:  When you put away a line with Inventory as the destination, inventory is automatically updated.

Lot and Serial Number Information
You can record lot and serial information or generate multiple lots and serial numbers for the material during put away.

If you select a receipt line for put away and the corresponding item is either lot or serial controlled, then you must enter
the lot and serial information. If the complete receipt line corresponds to a single lot or serial range, then you can update
the lot and serial information directly on the Put Away Lines page or the Put Away Line page. If not, then you can select
the Record Lots and Serial Numbers item from the Actions menu to enter new lots and serial numbers.

When putting away a transaction that has a receipt routing of Standard Routing or Inspection Required, you can
default lot and serial numbers that were previously entered on an advance shipment notice (ASN) or advance shipment
billing notice (ASBN). This can increase your efficiency (especially for high volumes) and reduce errors when receiving
lot and serial-controlled items.

Use the Record Lots and Serial Numbers page to view and select lot and serial numbers that were entered on an ASN or
ASBN against the purchase order schedule. On the Record Lots and Serial Numbers page, click the Select ASN Lots or
Select ASN Serial Numbers buttons to view the lots and serial numbers from the associated ASN or ASBN. After you
make your lot and serial number selections, you return automatically to the Record Lots and Serial Numbers page where
you can now make corrections such as delete, add, or override to the lot and serial numbers.
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Note:
• For lot-controlled, dual UOM items, the secondary quantity and UOM display on the Select ASN Lots page.

• The Select ASN Lots and Select ASN Serial Numbers buttons on the Record Lot and Serial Numbers page are
enabled for lot and serial-controlled items respectively, when an ASN or ASBN exists against the purchase order
schedule. The ASN or ASBN also has to have lots or serial numbers entered. For example, if an ASN exists, but
there are no lots or serial numbers, the buttons aren't enabled.

Alternatively, on the Put Away Lines and Put Away Line pages, you can select the Default Lots and Serial Numbers
from ASN check box to accept all the lot and serial numbers entered on the ASN or ASBN without going to the Record
Lots and Serial Numbers page. The Default Lots and Serial Numbers from ASN check box isn't visible by default on
these pages. Add it by selecting the option from the View menu.

The Default Lots and Serial Numbers from ASN check box is available for selection only if these conditions apply:

• You've previously enabled the Allow defaulting of lots and serial numbers from ASN option on the Manage
Receiving Parameters page.

• The item is lot controlled, serial controlled, or both.

• An ASN or ASBN exists for the purchase order schedule.

• The put away quantity is equal to the shipped quantity against the ASN line.

• Lot and serial information was entered while creating an ASN.

Inventory or Expense Destinations
You can put away items to inventory or expense destinations. For inventory items, provide the subinventory and locator.
For expense items, provide the deliver-to location.

E-signatures are captured for put aways only if the lines being put away have Inventory as the destination. If the line has
Expense as the destination, the e-signature isn't applicable and not captured.

Packing Units
You can enter the packing unit if material is kept inside a packing unit after put away or transfer.

Note:  If you put away to an inventory destination, packing unit information isn't tracked after the put away. However,
if you transfer material to a receiving subinventory, packing unit information will be available after completion of the
transaction.

E-signatures are captured during the correction flow only if a line being corrected has the status as Delivered. E-
signatures aren't applicable for other line statuses such as Received, Accepted, or Rejected.

Multiple Distributions
When a purchase order schedule contains multiple distributions and the receipt routing is set to direct delivery, the
destination type defaults to Multiple. You put away at the distribution level if the receipt routing is direct delivery. You
put away at the schedule level if the receipt routing is standard or inspection required. To expand the line and show all
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distributions, select the Show All Distributions item from the Actions menu of the Put Away Lines and Put Away Line
pages.

For requisition-sourced transfer order lines, select the Show All Distributions item from the Actions menu to obtain
the transfer order distributions and populate the receipt quantity for each distribution line. You can enter receipt
quantities at the distribution level and the quantities for each distribution line are validated against the associated
transfer order distribution quantity.

Note:  In addition to the show all distributions option, you can edit the line with multiple distributions by changing the
destination type from Multiple to Receiving.

Receipt Line Transfer
Transfer material by moving between different receiving subinventories. When you provide the receiving subinventory,
the receipt line status automatically moves to Transferred.

Split Lines
You can split a line to receive in partial quantities to different inventory locations.

Select Split Line from the Actions menu.

E-Signatures for Approval
If put away transactions are configured for approval using e-signatures, the E-Signature page opens when you put away
a line and click Submit. Use the page to approve the transaction. E-signatures are captured for put aways only if the
lines being put away have Inventory as the destination.

The e-signature IDs are recorded and available from the Manage All Lines and Transaction History pages.

For information about e-signatures, see the Oracle Fusion Cloud SCM: Using E-Signatures and E-Records guide,
available on the Oracle Help Center.

For information about how to configure e-signatures for supply chain management transactions, see the Oracle Fusion
Cloud SCM: Implementing Manufacturing and Supply Chain Materials Management guide, available on the Oracle Help
Center.

FAQs for Put Away Loads  

How can I put away a receipt line into multiple locations?  
Use the split line action to put away part of a receipt line or to distribute the receipt line to multiple locations. Select Split
Line from the Actions menu.
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What happens if I am putting away lines that are lot or serial
controlled?  
You must specify lot numbers and serial numbers.

You can enter the applicable lot and serial numbers directly into the table. Or, select the Record Lots and Serial
Numbers item from the Actions menu on the Put Away Lines page to record the applicable lot and serial numbers.

What's the difference between receiving and putting away
inventory and expense items?  
For receiving and putting away inventory items, you provide the subinventory, locator, and lot and serial information.

For receiving and putting away expense items, you provide the deliver-to location.

What happens if I change the defaulted transaction date?  
The changed transaction date must conform to the date tolerances set up on the Manage Receiving Parameters page.
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6  Create and Match Unordered Receipts

Unordered Receipts  
You can create an unordered receipt by receiving unordered material. Unordered material consists of items that arrive
at the warehouse without documentation such as a purchase order. You must match unordered receipts to a valid
document before you can inspect or put away the receipt lines.

The following aspects are important when creating and matching unordered receipts:

• Create receipt or return items

• New receipt or existing receipt

• Packing units, subinventories, and locators

• One-time items

• Prohibited tasks for unmatched items

• Unordered receipt process

Create Receipt or Return Items
When material arrives at your warehouse without documentation and you cannot link it to a backing document, you
must decide whether to create an unordered receipt or return the items to the supplier.

Your options include:

• Creating an unordered receipt
You can receive the material in a hold area. This allows the warehouse to move the material away from the
receiving docks. The receiving personnel can work on performing other receipts, while the manager searches
for the correct document details from the supplier. When you establish the document association, you can
match the unordered receipt to a document and proceed with inspecting or putting away the material to
storage.

• Returning the items to the supplier
You can return the material to the supplier. If your warehouse doesn't allow unordered receipts, then you must
send the material that arrives without complete documentation back to the corresponding supplier.

New Receipt or Existing Receipt
You can create a new receipt or add the unordered items from the shipment to an existing receipt. If you create a new
receipt, you access the Create Unordered Receipt page to enter the receipt header details. If you add the unordered
items to an existing receipt, you access the Add to Unordered Receipt page to add your receipt details.

Packing Units, Subinventories, and Locators
Many distribution centers have a large receiving area that is divided into many subinventories and locators. These
distribution centers also store received material in containers known as packing units. When creating the unordered
receipt, you can optionally enter packing unit, subinventory, and locator information.
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One-Time Items
You can create unordered receipts for infrequently ordered items that don't have an existing item definition. For one-
time items, you enter the item description, but you don't enter an item number.

Prohibited Tasks for Unmatched Items
You can't perform several transactions on an unordered receipt line until it's matched.

Here are the transactions that you cannot perform on unmatched receipts:

• Return to supplier

• Inspect receipt line

• Put away receipt line

Unordered Receipt Process
The unordered receipt process includes creating and matching the unordered receipt.

Here are the steps for creating an unordered receipt:

• Record receipt line details and navigate to the receipt header region.

• Specify the item, quantity, unit of measure, and receiving location for the receipt line.

• Create a new receipt or add unordered receipt lines to an existing receipt.

• Enter the receipt header information and submit the transaction.

Here are the steps for matching an unordered receipt:

• Search for unordered receipts to match.

• Select receipt lines to match.

• Select the document number (such as PO number) and line detail to match.

• Submit the unordered receipt line for matching.

Match Restrictions for Unordered Receipts  
When you're ready to match your unordered receipts to the correct documentation, you specify the purchase order
(PO) or return material authorization (RMA) number, receipt line, and receipt header information for which you want to
match the unordered receipt.

Oracle Receiving restricts the list of possible matching documents as follows:

• The PO must have the same supplier as the unordered receipt.

• The PO can't be in Final Closed or Canceled status.

• The PO must have at least one approved shipment in the same organization where you performed the
unordered receipt.
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For RMAs, the receiving organization on the RMA must be in the same organization where you performed the
unordered receipt.

• The item and the purchasing category on the PO must be the same as the item and purchasing category on the
unordered receipt (except for receipts of one-time items).

The item on the RMA must be the same as the item on the unordered receipt (except for receipts of one-time
items).

• You can match only to approved shipments.

• The document must have a receipt routing of inspection required or standard receipt.

Note:  If the shipment has a routing of direct delivery, the Allow Routing Override profile option must have
been selected during setup.

FAQs for Unordered Receipts  

Why can't I create an unordered receipt?  
The receiving parameter to allow the creation of unordered receipts isn't selected for your warehouse.

Why can't I create an unordered receipt for the item?  
The item specifications don't allow for the creation of an unordered receipt for this item.

Can I match unordered receipts to a consigned item?  
Yes, you can match unordered receipt lines to a consignment purchase order. The match transaction date becomes the
aging period onset date.
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7  Receipt Exceptions

Receipt Exceptions  
An exception is any deviation noticed during the receiving process. A receiving agent or warehouse manager can mark
a line for an exception during receipt, inspection, or put away.

The following questions explain exceptions:

• Why would you mark a line as an exception?

• What happens if you mark a line as an exception?

• How do you search for and resolve exceptions?

Why would you mark a line as an exception?
Examples of when you would mark a line as an exception include:

• Material is received in a pack with the seal broken, but all other contents are intact. In this case, a receiving
agent could mark the receipt line as an exception so that during inspection the contents of the pack can be
inspected in detail.

• A supplier has sent a substitute item against the purchase order. The receiving agent receives the material, but
the receiving agent marks the receipt line as an exception due to the substitute item.

What happens if you mark a line as an exception?
Even if a receipt line is marked as an exception, you can perform all receiving transactions on this line.

How do you search for and resolve exceptions?
The warehouse manager or receiving agent can perform a search for lines with exceptions by applying the
corresponding filter during search. Then, the warehouse manager or receiving agent can resolve exceptions by
deselecting the Exceptions check box for lines with exceptions.

FAQs for Exceptions  

How can I mark part of a receipt line as an exception?  
Use the split line action to create two separate lines. Select Split Line from the Actions menu. After you split the line,
select the Exceptions check box for the newly created line.

43



Oracle Fusion Cloud SCM
Using Receiving

Chapter 7
Receipt Exceptions

44



Oracle Fusion Cloud SCM
Using Receiving

Chapter 8
Correct Receipts

8  Correct Receipts

Corrections  
Correcting received lines is the process of correcting the transaction quantity of material received.

You must have a valid receipt before correcting returns. These aspects are important when correcting receipts:

• Correction eligibility

• Lot and serial number information

• Positive correction or negative correction

• Correction updates

• Transfer orders

• E-signatures for approval

Correction Eligibility
You can correct receipt lines if they are associated with a purchase order (PO), advance shipment notice (ASN), return
material authorization (RMA), requisition, or in-transit shipment and have one of the following statuses:

• Received

• Accepted

• Rejected

• Put Away

• Transferred

• Returned to Receiving

• Returned to Supplier

• Returned to Customer

In addition, if you select an item for correction, the correction quantity must fall within the tolerance level set for the
document. If the correction quantity falls outside the tolerance limit, then appropriate action is taken based on the
tolerance action specified for the document.

Lot and Serial Number Information
If you select a receipt line for correction and the corresponding item is either lot or serial controlled, then you must enter
the lot and serial information.

If the complete receipt line corresponds to a single lot or serial range, then you can update the lot and serial information
directly on the Correct Lines page or the Correct Line page. If not, then you can select the Record Lots and Serial
Numbers item from the Actions menu to enter new lots and serial numbers.

In the case of a positive correction, you can generate a new lot or serial number for a lot or serial controlled item. In the
case of a negative correction, you can only select from existing lot and serial numbers that already exist for the receipt
line.
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Positive Correction or Negative Correction
You can enter positive or negative corrections to any receiving transaction. A positive correction increases the receipt
line quantity by the specified quantity. A negative correction decreases the receipt line quantity by the specified
quantity.

Correction Updates
When you make corrections, the following updates apply:

• When you correct a customer return transaction, the RMA is updated.

• When you correct a receiving transaction, inventory balances are automatically updated if they have already
been moved into inventory.

• When you make corrections to a receipt created against an ASN, your purchasing, in transit, and inventory
supplies are automatically updated.

Transfer Orders
You cannot correct a transfer order that has been returned or put away.

E-Signatures for Approval
If correct transactions are configured for approval using e-signatures, the E-Signatures page opens when you correct a
line and click Submit. Use the page to approve the transaction.

The Electronic Signature IDs are recorded and available from the Manage All Lines and Transaction History pages.

For information about e-signatures, see the Oracle Fusion Cloud SCM: Using E-Signatures and E-Records guide,
available on the Oracle Help Center.

For information about how to configure e-signatures for supply chain management transactions, see the Oracle Fusion
Cloud SCM: Implementing Manufacturing and Supply Chain Materials Management guide, available on the Oracle Help
Center.

Consignment Line Corrections  
You can correct receipt lines containing both owned and consigned items. Consigned items are items that are in the
possession of one party, but remain the property of another party. When a consignment line is consumed, it transfers to
owned status.

These aspects are important when correcting receipts with consigned lines:

• Consignment line indicator

• Correction eligibility

• Correction process

• Consigned and owned material
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Consignment Line Indicator
If your receipt line is for a purchase order containing consigned items, the page displays the Consignment Line check
box as selected for that line. If the Consignment Line check box is not visible on the page, select the field from the
View > Columns menu.

Correction Eligibility
You can correct consigned receipt lines if they have one of the following statuses:

• Received

• Transferred

• Accepted

• Rejected

• Put Away

• Returned to Supplier

In addition, if you select an item for correction, the correction quantity must fall within the tolerance level set for the
document. If the correction quantity falls outside the tolerance limit, then appropriate action is taken based on the
tolerance action specified for the document.

Correction Process
The process for positive or negative corrections on receipt lines with consigned items is same as that for regular items.
You can specify the quantity to correct for these types of receipt lines and submit the transactions. If you select a receipt
line for correction and the corresponding consigned item is either lot or serial controlled, you must consider the correct
owning party when selecting the lot and serial number to be corrected.

Consigned and Owned Material
When correcting receipt lines with a transaction type of Put Away, it is possible that for the consigned material that is
received from the supplier, part has already been consumed. This means that out of the total quantity received, part of
the quantity is consigned, and part of the quantity is owned (already consumed) inventory.

If the receipt line that you want to correct contains both consigned and owned (consumed) quantities, the Correct Lines
page displays only the consigned quantity (and not the consumed quantity). Any positive correction to the consumed
quantity is treated as a new receipt.

Related Topics
• Corrections
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FAQs for Corrections  

What happens if I am correcting receipt lines that are lot or serial
controlled?  
You must specify lot numbers and serial numbers.

Select the Record Lots and Serial Numbers item from the Actions menu on the Correct Lines page to record the
applicable lot and serial numbers. If you are making a positive correction, you can generate new lots when correcting
the receipt. If you are making a negative correction, you can only select existing lot and serial numbers.

What happens if I am correcting a receipt line with consigned
material that has already been consumed?  
Any positive correction to the consumed quantity is treated as a new receipt.

Why can't I correct my transfer order?  
You cannot correct a transfer order that has been returned or put away.
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9  Return Receipts

Returns  
Returning received lines is the process of moving the material received in the warehouse back to the supplier, customer,
or receiving. You must have a valid receipt prior to processing returns.

These aspects are important when returning receipts:

• Return eligibility

• Return quantity

• Lot and serial number information

• Subinventories and locators

• Debit memos

• Returns processing

• Transfer orders

Return Eligibility
The following aspects determine whether a receipt is eligible to be returned:

• Purchase order status: You can return an item to the supplier if the purchase order is not in either Canceled or
Final Closed status.

• Unordered receipt matching: You must match unordered receipts before they can be returned.

• Source type: You cannot return receipt lines with internal source types (interorganization shipments).

• RMA status: You cannot return RMAs to the customer if the material has been delivered to inventory.

Return Quantity
If you select an item for return, then the return quantity must be less than or equal to the recorded quantity. If your
organization does not allow negative balances, and the return quantity will result in a negative on-hand quantity, then
you cannot proceed with the transaction.

You have the option to enter a complete or partial return. If you are returning only part of a receipt line, the return
quantity will be less than the recorded quantity. If you are returning the entire receipt line, then the return quantity will
equal the recorded quantity.

Lot and Serial Number Information
If you select a line to return and the corresponding item is either lot or serial controlled, then you must enter the lot and
serial information. If the complete receipt line corresponds to a single lot or serial range, then you can update the lot and
serial information directly on the Return Lines page or the Return Line page. If not, then you can select the Record Lots
and Serial Numbers item from the Actions menu to enter new lots and serial numbers. You cannot generate any new
lot or serial numbers during returns.
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Subinventories and Locators
When you return items to receiving, you have the option of selecting the subinventory and locator, as well as the return
from subinventory and locator. If you don't select a subinventory and locator, the application uses the default receiving
subinventory and locator for the warehouse.

Debit Memos
Depending on the debit memo setting for the supplier site, the application can automatically create a debit memo when
a return is processed for the receipt line.

You can also manually create a debit memo for the return transaction.

Note:  You can't automatically create a debit memo for returns of consigned items.

Returns Processing
Return processing differs depending on whether you are returning items to the supplier, customer, or receiving:

• Supplier: When you return items to the supplier, Oracle Receiving creates both a Return to Receiving and a
Return to Supplier transaction.

Receiving also reopens the associated purchase order for the return quantity by reducing the original receipt
quantity.

• Customer: When you return items to the customer, Receiving creates both a Return to Receiving and a Return
to Customer  transaction.

For customer returns, if you return the item back to the customer, Receiving updates the RMA to reflect the
returned quantity.

• Receiving: When you return items to receiving, you can optionally select the subinventory and locator. If you
don't select a subinventory and locator, the application uses the default receiving subinventory and locator for
the warehouse.

Transfer Orders
When you request a return against a transfer order, the returns process associates the return transfer order with the
original transfer order, and the physical return of the material is optional.

The following exceptions apply to returns against transfer orders:

• You can't perform return transactions for expense destination transfer orders.

• When you initiate a return against a transfer order, you can no longer correct the returned quantity.

• You can't combine the transfer order return lines with other purchase order or RMA return lines on the same
return receipt.

• You can't perform return transactions for an intraorganization transfer order.
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Consignment Lines Returns  
You can return both consigned and owned receipt lines. Consignment lines are receipt lines containing items that are
in the possession of one party, but remain the property of another party. When a consignment line is consumed, it
transfers to Owned status. You can return consignment lines to either the supplier or receiving.

These aspects are important when returning receipts with consigned lines:

• Returns to supplier or receiving

• Returns containing both consigned and owned items

• Debit memos

• Lot and serial number information

Returns to Supplier or Receiving
Return processing for consignment lines differs depending on whether you are returning items to the supplier or
receiving:

• Supplier: You can return consigned items back to the supplier. When you return items to the supplier, Oracle
Receiving creates both a return to receiving and a return to supplier transaction. Receiving also reopens the
associated purchase order for the return quantity by reducing the original receipt quantity.

• Receiving: Consigned items that are received and put away to inventory can be returned to receiving. You
perform a two-step process that includes returning the items to receiving, and then returning the items to the
supplier. When you return items to receiving, you can optionally select the subinventory and locator. If you
don't select a subinventory and locator, the application uses the default receiving subinventory and locator for
the warehouse.

Note:  Consignment lines don't apply to customer returns. You cannot return consigned items to the customer.

Returns Containing Both Consigned and Owned Items
You can return receipt lines that contain both consigned and non-consigned (owned) items. When you select a receipt
line to return, if that receipt line contains both consigned and owned items, two separate return lines display on the
page. The application automatically selects the Consigned check box for the return line containing the consigned items.
You specify the quantity to return against each line separately, and submit the transaction.

The return quantity must be less than or equal to the received quantity. The return transaction considers both the
available owned and consigned quantities individually.

Debit Memos
You can create debit memos for returns of consumed items. Consumed items are in Owned status. Depending on
the debit memo setting for the supplier site, the application can automatically create the debit memo when a return
is processed for the consumed receipt line. You can also manually create a debit memo for the consumed return
transaction.

You cannot create a debit memo for items that are in Consigned status. The supplier already owns the items in
Consigned status. Therefore, there is no existing invoice against which to create a debit memo.
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Lot and Serial Number Information
If you select a line to return and the corresponding consigned item is either lot or serial controlled, then you must enter
the lot and serial information. If the complete receipt line corresponds to a single lot or serial range, then you can update
the lot and serial information directly on the Return Lines page or the Return Line page. If not, then you can select
the Record Lots and Serial Numbers item from the Actions menu to enter new lots and serial numbers. You cannot
generate any new lot or serial numbers during returns.

Related Topics
• Returns

Transfer Order Returns  
The approach to returning internal material transfers begins in Oracle Receiving. You can request a return against a
transfer order through the Manage Returns user interface.

These aspects are important when returning transfer orders:

• Return transfer order process

• Physical material return

• Corrections to returned transfer orders

• Return exceptions for transfer orders

Return Transfer Order Process
Receiving associates return transfer orders with the original transfer order, and the physical return of the material is
optional.

When you initiate a return against a transfer order, the application creates a new transfer order with a transfer type of
return transfer order. If the physical return of material is required, the transfer order is passed to Oracle Shipping. If the
physical return of material isn't required, the transfer order does not pass to Shipping, and instead is set to a status of
closed.

During the return process, Receiving calculates the price and tax for the return transfer order before submitting the lines
for processing. The application obtains the tax and prices amounts from the original transfer order and creates them in
reverse.

Physical Material Return
The Physical Material Return Required check box displays on the Return Lines user interface. If you deselect this field,
the return is considered an accounting only return. If you select this field, transactions are created for the physical return
of the material.

For returns that do not require physical return of material, shipment lines and reservations are not created. The transfer
order line is set to a status of closed automatically, and the application does not update the shipped or received
quantity. You can use the transfer order document for tax, accounting, and audit trail purposes.

For returns that require physical return of material, shipment lines and reservations are created. You can pick, pack, and
ship physical material returns.
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Corrections to Returned Transfer Orders
Once material from a transfer order is put away, you cannot correct the receipt quantity. However, you can correct the
receipt quantity on a transfer order prior to putting away the transaction.

Return Exceptions for Transfer Orders
Here are the exceptions for returns against transfer orders:

• Once you initiate a return against a transfer order, you can no longer correct the returned quantity.

• You can't combine transfer order return lines with other purchase order or RMA return lines on the same return
receipt.

• You can't perform return transactions for an intraorganization transfer order, which moves material from
subinventory to subinventory within an organization.

• The application does not initiate transfer order return transactions if the material is not physically available. For
example, if other reservations exist for the same material.

• You can only return inventory destination transfer orders. You cannot return expense destination transfer
orders.

How Return to Supplier Transactions with Shipping
Documents Are Processed  
When you need to return items to the supplier, you may choose to print shipping documents for transporting the
returned items back to the supplier.

Returns may be needed when a customer rejects an item from their received shipment, a defect is found internally, and
so forth. To print shipping documents for the return, follow the two-step return process that starts in Oracle Receiving
and continues through to Oracle Shipping.

Settings That Affect Return to Supplier Transactions
To print shipping documents for your return to supplier transactions select the Print Shipping Documents for Returns
to Suppliers option on the Manage Receiving Parameters page.

Note:  The Print Shipping Documents for Returns to Suppliers option is a one-time setup step for your
organization. You don't set this up per transaction.

Shipping documents print for return to supplier transactions when all of these conditions are true:

• The material is delivered (through put away receipts or direct receipt).

• The customer is returning to the supplier (and not returning to receiving).

• The goods are delivered to an inventory location (subinventory and locator) and not to an expense location.

If any of these conditions aren't satisfied, the print shipping documents aren't printed.

53



Oracle Fusion Cloud SCM
Using Receiving

Chapter 9
Return Receipts

How Return to Supplier Transactions Are Processed
Return to supplier transactions are processed in two steps:

1. Create the return to supplier transaction in Receiving.
The receiving agent has an offline interaction with the supplier to obtain the return material authorization
number for the return. Then, the receiving agent creates the return to supplier transaction by providing details
such as the returned quantity and return material authorization (RMA) number. Finally, the receiving agent
submits the transaction for processing and the transaction moves to Shipping.

2. Create and confirm the return to supplier shipments in Shipping.
Shipping treats the items on the return to supplier transaction as a noninventory shipment and stages the
items without creating a shipment. Noninventory shipments don't generate inventory transactions or affect on-
hand balances. Therefore, the application skips actions such as backorder, cycle count, pick release, and record
serials, since these actions aren't applicable to noninventory shipments. The shipping manager searches for
the return transactions, assigns the return to supplier lines to shipments, and performs ship confirm. Upon ship
confirm, Shipping generates the shipping documents for the customer, and creates and sends the automatic
shipment notices (ASNs) automatically to the supplier.

Corrections to Return to Supplier Transactions With Shipping Documents
You can make corrections to return to supplier transactions. The corrections are reflected on shipping documents up
until the returned products are shipped within the Shipping application. If you make corrections after the products are
shipped, the changes are still accepted in Receiving. Receiving maintains automated interfaces with Oracle Payables,
Oracle Cost Management, and Oracle Purchasing to share the corrected quantity information The table explains when
changes are allowed within the Shipping application based on the type of correction to the return to supplier transaction
and the associated shipment status.

Action Status of Shipment in Shipping Shipping Response

The return to supplier transaction sends an
update with an increase in quantity.
 

Shipped
 

An increase in the quantity is accepted at the
end of shipping and a new delivery line is
created.
 

The return to supplier transaction sends an
update with an increase in quantity.
 

Not shipped
 

Updates are accepted in Shipping.
 

The return to supplier transaction sends an
update with an increase in quantity.
 

Partially shipped
 

Updates are accepted in Shipping for the
unshipped lines. Updates for the lines already
shipped aren't accepted.
 

The return to supplier transaction sends an
update with a decrease in quantity.
 

Shipped
 

No updates are accepted in Shipping.
 

The return to supplier transaction sends an
update with a decrease in quantity.
 

Not shipped
 

Updates are accepted in Shipping.
 

The return to supplier transaction sends an
update with a decrease in quantity.
 

Partially shipped
 

Updates are accepted in Shipping for the
unshipped lines. Updates for the lines already
shipped aren't accepted.
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Action Status of Shipment in Shipping Shipping Response

The return to supplier transaction sends an
update that reduces the quantity to zero.
 

Shipped
 

No updates are accepted in Shipping.
 

The return to supplier transaction sends an
update that reduces the quantity to zero.
 

Not shipped
 

Shipping accepts the change, but setting
the quantity to zero cancels the shipment in
Shipping.
 

The return to supplier transaction sends an
update that reduces the quantity to zero.
 

Partially shipped
 

Updates are accepted in Shipping for the
unshipped lines. Other lines aren't accepted
because that part of shipment is canceled.
 

The return to supplier transaction makes
further updates after setting the quantity to
zero.
 

Canceled
 

You can't make further updates to a transaction
that's already canceled. You must create a new
return to supplier transaction.
 

Example
When your organization's customer initiates a return, they return the item to your organization. Your organization must
then send the items back to the outsourced manufacturer or supplier. Therefore, instead of your customers returning
the items directly to the suppliers, your customer's items are routed through your organization to your organization's
suppliers. In this instance, you must create shipping documents for transporting the items back to the suppliers.

Related Topics
• What's a noninventory shipment?

FAQs for Returns  

How can I return part of a receipt line?  
Enter the quantity to return on the Return Lines page. If you're returning part of a receipt line, the entered return
quantity is different than the recorded quantity. If you're returning the entire receipt line, then the return quantity equals
the recorded quantity.

Why doesn't my purchase order appear in the Return Receipts
page search results?  
The purchase order must have:

• At least one approved shipment for which the ship-to organization is the same as the current, active
organization

• A receipt created for it
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What happens if I am returning receipt lines that are lot or serial
controlled?  
You must specify lot numbers and serial numbers.

Select the Record Lots and Serial Numbers item from the Actions menu on the Returns Lines page to record the
applicable lot and serial numbers. You cannot generate any new lot or serial numbers when processing the return.

What happens if I am returning material that has already been
consumed?  
The debit memo setting at the supplier site is considered. If this setting specifies to create a debit memo, then the
application creates a debit memo automatically since the consumption advice has already been generated.

You can also manually create a debit memo for the consumed return transaction.

What's a return to supplier transaction?  
A transaction that you use to return items to a supplier and receive credit for the items without interacting directly with
the supplier.

The return is routed through the organization to the outsourced manufacturer or supplier. The organization sends the
items back to the supplier.

What happens if I select the Physical Material Return Required
check box?  
Transactions are created for the physical return of the material, and shipment lines and reservations are created. You
can pick, pack, and ship physical material returns.

If you don't select this check box, the return is considered an accounting only return. Shipment lines and reservations
aren't created, the transfer order is set to a status of closed automatically, and the shipped or received quantities aren't
updated.

56



Oracle Fusion Cloud SCM
Using Receiving

Chapter 9
Return Receipts

What's the difference between a physical and accounting only
internal material transfer return?  
If the physical return of material is required, the transfer order is interfaced to Oracle Shipping.

If the physical return isn't required (accounting-only internal material transfer return), the transfer order isn't interfaced
to Oracle Shipping.

A transfer order type of Return is created for both scenarios (with or without physical returns).

Can I initiate a return against a transfer order?  
Yes. You can return an inventory destination transfer order, but you can't return an expense destination transfer order.
Inventory destination transfer orders have a destination type value of Inventory. Expense destination transfer orders
have a destination type value of Expense.
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10  Manage Returns Without Receipt

Supplier Returns Without Receipts  
You can return goods to a supplier without referencing the original receipt. This is useful when returning goods with a
receipt reference isn't practical.

Returning goods to the supplier without a receipt reference lets you efficiently return a large number of goods that
could have been ordered and received at various times. You can also save money by returning components that arrived
damaged from a designated location. And, you can reduce the amount of time required to return goods by eliminating
the need to match returns with receipts.

When using supplier returns without a receipt reference, you can:

• Manage supplier returns without receipts

• View supplier returns without receipts in shipping

• Review supplier return transactions as completed inventory transactions

Manage Supplier Returns Without Receipts
Use the Manage Supplier Returns Without Receipt task to manage supplier returns without a receipt reference.

• Search, create, and edit supplier returns without a receipt.

You can create supplier returns for scrap or shipment transactions depending on the Physical Material Return
Required check box. You can return the shipment to the supplier when your supplier requires a physical return
of the goods. Enter a value for the Requested Date for these shipping-related transaction lines. These return
lines are processed through Shipping. You can also scrap the material when your supplier requests that you
dispose of the goods. These scrap returns perform the scrap transaction in Inventory and don't process through
Shipping.

When creating a supplier return without a receipt, you must enter a supplier and supplier site combination for
the return at the header level. All return lines will have the same supplier and supplier site combination.

You can edit supplier returns that are saved as incomplete and not yet submitted for processing. Once
submitted, you can't edit supplier returns.

• Submit the supplier returns for scrap and shipment together.

When you create or edit your supplier returns without receipt, submit the saved supplier returns for scrap and
shipment lines together. If you encounter an error while submitting, you can review the error on the supplier
return lines, fix the issue, and resubmit the supplier return for processing.

• View supplier returns without receipt after they're submitted.

View the supplier returns that have been submitted for processing. Review the status of the individual lines.

• Delete supplier returns lines that are in Incomplete status.

• Cancel supplier return lines that are in Pending fulfillment status.
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View Supplier Returns Without Receipts in Shipping
For supplier return lines with the Physical Material Return Required option selected, you must physically ship the
material back to the supplier through the Shipping processes. Use the Manage Shipment Lines task in Shipping to
view shipment lines for supplier returns without receipts that require the return of physical goods. Search for and view
supplier returns without receipts by selecting Unreferenced Supplier Return as the order type in the search criteria.

Use the tasks in Shipping to:

• Pack

• Assign to shipments

• Screen for compliance

• Manifest with carrier

• Confirm shipments

• Print shipping documents

The supplier return line status is updated to Fulfilled upon ship confirm.

Note:  You can't group lines from different supplier returns into a single shipment because the supplier return number
is a required shipment grouping criteria.

Review Supplier Return Transactions as Completed Inventory Transactions
Use the Review Completed Transactions task in Inventory to search for and review supplier return transactions as
completed inventory transactions.

• Review supplier return without receipt transactions.

You can select a source type of Supplier Return Without Receipt Reference and a transaction type of either
Supplier Return Scrap Without Receipt Reference or Supplier Return Shipment Without Receipt Reference
to search for the completed transactions for supplier returns without receipt.

• Search for supplier returns using the supplier return number.

You can enter the supplier return number in the Source Reference field to search for supplier return without
receipt transactions on the Review Completed Transactions page.
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Note:  When returning material to suppliers without a receipt, the following apply:

• You can return material to suppliers without a receipt only from subinventory that's not reservable.

• Only stockable and transactable items are eligible for supplier returns without a receipt.

• You should manually create a debit memo for supplier returns without a receipt.

• Intercompany transactions and consigned inventory transactions aren't supported for supplier returns
without a receipt.

• You can't pick release or pick confirm an supplier return order type that's not referenced.

• You can use the Supplier Returns REST service to search, create, edit, cancel, delete, or submit the supplier
return transactions.

• Supplier return transactions are costed at the current item cost.

FAQs for Returns Without Receipt  

Why would I create a supplier return without a receipt reference?  
In some situations, it might be impractical for you to return goods to your supplier using the original receipt.

For example, let's say your supplier issues a mass recall for a particular good. Because you regularly order this good,
you have thousands of on-hand quantity that you received at various times. It would be nearly impossible to determine
which goods came in on which receipt. And, it would take far too many hours to search for each receipt and then return
the individual quantity indicated on each receipt.

Returning goods to the supplier with a receipt reference enables you to:

• Efficiently return a large number of goods that were ordered and received at various times

• Save money by returning components that arrived damaged from a designated location

• Reduce the amount of time required to return goods by eliminating the need to match returns with receipts

Can I enter the cost for a supplier return without receipt?  
No, you can't enter the cost on a return line for a supplier return without a receipt. Oracle Cost Management uses the
current item cost.

How can I return goods to a supplier without using the original
receipt?  
Use the Manage Supplier Returns Without Receipt task to search, create, and edit supplier returns without a receipt.
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11  Back-to-Back Receipts

Promise Sales Orders In Your Back-To-Back Flow  
Back-to-back is a supply chain management technique where you receive supply at a warehouse then ship it directly to
your customer. You can use Global Order Promising to help fulfill a back-to-back order.

You typically use back-to-back fulfillment to fulfill a high cost or a slow moving item. You usually don't stock the item in
inventory but instead build it in reply to demand.

Here's the general flow:

• You create a sales order and submit it to fulfillment.

• Promising creates and schedules supply for the order.

• You procure and receive supply in your warehouse.

• Supply Chain Orchestration reserves supply, then Inventory Management manages it in inventory during
shipping.

You set up your implementation to automatically do this work, including selecting the source, reserving supply until its
fulfilled, and automatically adjusting fulfillment when supply or demand changes.

For details, see Overview of Back-to-Back Fulfillment.

FAQs for Back-to-Back Receipts  

What's a back-to-back transfer order?  
An internal material transfer order to transfer supply from the source location to the destination location to fulfill a back-
to-back sales order.

The back-to-back transfer order is automatically reserved against the associated back-to-back sales order by Oracle
Supply Chain Orchestration. When the transfer order is received and put away at the destination location, the supply-
side of the reservation is automatically moved from the transfer order to the new on-hand inventory. This action
maintains the reservation of the supply against the back-to-back sales order until shipping.

What's a back-to-back purchase order?  
An order to procure product from an external supplier to fulfill a back-to-back sales order.

Oracle Supply Chain Orchestration automatically reserves the back-to-back purchase order against the associated back-
to-back sales order. When the purchase order is received and put away at the destination location, the supply-side of
the reservation automatically moves from the purchase order to the new on-hand inventory. This action maintains the
reservation of the supply against the back-to-back sales order until shipping.
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What's the difference between receiving a regular supply order
and a back-to-back supply order?  
Receiving transactions against back-to-back supply orders process the same as regular supply orders. One exception
is the reservations handling when creating receipts for supply orders that are received and put away to inventory at
receiving time (direct routing).

Put away of a regular receipt and put away of a back-to-back receipt are similar. However, there is an exception in the
processing of the reservation that was made against the supply order (purchase order or transfer order). In both cases,
the reservation is moved from the supply order to the new on-hand inventory as part of the put away transaction
process. The only difference is:

• For a regular receipt, the reservation is transferred to the new on-hand inventory at the subinventory and
locator level.

• For a back-to-back receipt, the reservation is transferred to the new on-hand inventory at the organization level.

What's the difference between the put away of a regular receipt
and a back-to-back receipt?  
The put away is similar. However, there is an exception in the processing of the reservation that was made against the
supply order (purchase order or transfer order).

In both cases, the reservation is moved from the supply order to the new on-hand inventory as part of the put away
transaction process. The only difference is:

• For a regular receipt, the reservation is transferred to the new on-hand inventory at the subinventory and
locator level.

• For a back-to-back receipt, the reservation is transferred to the new on-hand inventory at the organization level.

What's the difference between the processing of returns for a
regular receipt and a back-to-back receipt?  
The processing is similar in that there is no difference in the returns handling of a transfer order receipt. However, when
creating a return transaction against a receipt for a back-to-back purchase order, there is a difference in the processing
of the reservation.

When handling returns for a back-to-back purchase order, the application attempts to maintain the reservation. When
the receipt was initially put away, the supply side of the reservation would have automatically moved from the purchase
order to the new on-hand quantity for the quantity put away. When creating a return transaction for this quantity, the
application automatically attempts to maintain that reservation by moving the returned quantity back from the on-hand
supply to the new open purchase order supply.
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The application performs this action as long as there are no downstream actions against the reservation that change
the reservation. For example, situations that can prohibit this automatic action include:

• Manually changing the reservation using the Reservations and Picks page, such as: changing quantities,
assigning subinventories and locators to the reservation, and changing the demand side of the reservation
(changing the sales order)

• Initiating the shipping processes to assign picks against the sales order
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12  Drop Shipments

Promise Sales Orders in Your Drop Ship Flow  
Drop ship is a supply chain & manufacturing technique where the seller relies on a supplier or contract manufacturer to
build, store, and ship an item to your customer.

You can use Global Order Promising to help fulfill a drop shipment.

Here's what you need to do:

• Create the global sourcing rule that Promising will use to identify suppliers who can fulfill the drop ship, then
select one of them to do it. Specify the supplier calendar, supplier capacity, and supplier lead times.

• Create the assignment that Promising will use to assign the item to the sourcing rule that you just created.

• Go to one of the Supply Chain Planning work areas, then click Tasks > Maintain Supply Network Model. In the
Search Results area, click View > Columns, then display the Drop Ship Validation Organization attribute. Use
the Drop Ship Validation Organization attribute to create a validation organization for your drop shipment.

Get more:

• Learn what a drop shipment is and how the flow works. For details, see Overview of Drop Ship in Order
Management.

• Learn how Promising fits in the drop ship flow. For details, see How Drop Ship Works in Order Management.

• Learn how to set it up so it works with Order Management. For details, see Set Up Drop Ship in Order
Management.

Related Topics
• Promising Modes for ATP Rules

• Assign Your Sourcing Rules

• Source Your Supply Chain

• Assignments and Rules

How You Record the Shipment of Drop Ship Products to
the Customer  
You can record the delivery of a product drop shipped directly to the customer site.

When recording the shipment to the customer, use one of the following options:

• AP Invoice option

• ASN (advance shipment notice) option

Both options acknowledge delivery of the product and initiate downstream processing for costing and billing.
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You set up the process flow option for generating drop ship receipts using the Manage Drop Ship Financial Flows page.

AP Invoice Option
Use this option for supplier sites that don't send ASNs. The arrival and entry of the AP invoice automatically initiates
downstream processes to cost and bill the shipment.

ASN Option
Use this option for supplier sites that generate ASNs. The arrival of the ASN automatically initiates downstream
processes to cost and bill the shipment.

Related Topics
• How You Use the AP Invoice Option for Drop Ship Purchase Orders

• Create an ASN on a Drop Ship Purchase Order

How You Use the AP Invoice Option for Drop Ship
Purchase Orders  
To use the AP Invoice option to record the shipment of a drop ship purchase order:

1. The supplier sends an invoice to the seller.
2. The seller's accounts payable department enters or loads the invoice into the application.
3. Run the transaction processes listed in the following table to pass the invoice event into Oracle Receiving.

Process Description

Transfer Invoice Details to Supply Chain
Financial Flow Orchestration
 

Generates a drop ship receipt and drop ship delivery completing the processing in Receiving.
 

Transfer Ownership Change Events to
Receiving
 

Transfers the orchestrated invoice event into a receipt format in the Receiving Open Interface.
 

Manage Receiving Transactions
 

Generates a drop ship receipt and drop ship delivery completing the processing in Receiving.
 

Create an ASN on a Drop Ship Purchase Order  
To create an ASN (advance shipment notice) against a drop ship purchase order in the Supplier Portal:

1. Sign in to the Supplier Portal and navigate to the Create ASN page.
2. Search for the drop ship purchase order using the purchase order number.
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3. Select the relevant purchase order lines and click the Create ASN button.
4. Enter the details of the shipment, including the quantity, and click the Submit button.

You receive an acknowledgment that the ASN was created.

Note:  Alternatively, a warehouse manager can enter an ASN by clicking the Create ASN task from the task panel of
the Inventory Management work area.

Related Topics
• How You Record the Shipment of Drop Ship Products to the Customer

• How You Use the AP Invoice Option for Drop Ship Purchase Orders

• Promise Sales Orders in Your Drop Ship Flow

Considerations for Printing Shipping Documents for
Drop Ship Orders  
You can select whether or not you want to print shipping documents for drop ship orders. To print shipping documents
for these transactions, select the Print shipping documents for drop ship orders option on the Manage Receiving
Parameters page.

In the Setup and Maintenance work area, use the following:

• Offering: Manufacturing and Supply Chain Materials Management

• Functional Area: Receiving

• Task: Manage Receiving Parameters

Note:  The Print shipping documents for drop ship orders option is a one-time setup step for your organization.
You don't set this up per transaction.

Print Shipping Documents
If shipping documents are required for your drop ship orders, then your organization selects the Print shipping
documents for drop ship orders option on the Manage Receiving Parameters page. For example, you might select this
option when the supplier for your organization creates an advance shipment notice (ASN) for the drop ship order. This
option is a one-time setup step for your organization and can't be changed for individual transactions. Complete the
drop ship order in two steps:

1. The supplier creates an ASN in the Supplier Portal. Alternatively, a warehouse manager can enter an ASN by
clicking the Create ASN task from the task panel of the Inventory Management work area.

2. The ASN creates a shipment in Closed status for the drop ship order. The shipping manager can print the
packing slip, bill of lading, and commercial invoice for drop shipments.

Note:  The shipping paperwork for a drop ship order is similar to that of a regular sales order.
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Not Printing Shipping Documents
If shipping documents aren't required, don't select the Print documents for drop ship orders option on the Manage
Receiving Parameters page. Your drop ship order is completed in one step.

Related Topics
• How You Record the Shipment of Drop Ship Products to the Customer

• How You Use the AP Invoice Option for Drop Ship Purchase Orders

• Create an ASN on a Drop Ship Purchase Order

FAQs for Drop Shipments  

What's the difference between a purchase order return and a drop
ship purchase order return?  
For a regular purchase order return, you can return goods to either receiving or the supplier.

For a drop ship purchase order return, you can only return goods to the supplier. You can't return goods to receiving.

What's a drop ship purchase order?  
An order shipped from a supplier directly to the end customer, without the handling, stocking, or delivery of goods.

What are drop ship receipts and drop ship deliveries?  
Receipt and delivery records generated to support downstream accounting functionality and to allow for customer
returns of drop ship purchase orders. These receipt and delivery records don't affect inventory balances.
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13  Receiving Processes and Reports

Pay on Receipt  

Pay on Receipt Process  
The Pay on Receipt process enables you to automatically create standard, unapproved invoices for payment of goods
based on receipt transactions. Invoices are created using a combination of receipt and purchase order information.

You can automatically create invoices with multiple items and distribution lines, and include tax. You define which
supplier sites participate in Pay on Receipt and enforce matching rules to ensure that the proper payments are made to
the suppliers.

Important features of the Pay on Receipt process include:

• Interfacing with Oracle Accounts Payable

• Setting up suppliers and supplier sites

• Matching invoices to purchase orders or receipts

• Delaying payment on receipt

• Creating invoices with multiple items and multiple distribution lines

• Defining invoice consolidation levels

• Other features

Interfacing with Accounts Payable
The Pay on Receipt program automatically creates an invoice batch depending on the options set for the supplier and
supplier site. The supplier site must be set up as a Pay on Receipt site. Specifically, the Pay on receipt option must be
selected for the supplier site for self-billed invoices.

Setting Up Suppliers and Supplier Sites
You can enter supplier information on the Sites tab of the Edit Suppliers page to identify which suppliers are eligible for
Pay on Receipt and can have their invoices automatically created using the Pay on Receipt program.

Matching Invoices to Purchase Orders or Receipts
When the Pay on Receipt process runs, it automatically performs invoice matching to the purchase order or receipt,
depending on which Invoice Match option was chosen for the shipment.

Delaying Pay on Receipt
You may want to allow time for corrections or returns against the receipts before using the Pay on Receipt process to
automatically convert the receipts into invoices. The ERS aging period profile option enables you to specify this delay
period between the receipt date and the invoice creation date.
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Creating Invoices with Multiple Items and Multiple Distribution Lines
When creating multiple distribution lines for invoices with partial receipt quantities, the Pay on Receipt process prorates
the charges across all your purchase order distribution lines (for the received item).

Defining Invoice Consolidation Levels
The level of invoice consolidation determines how the Pay on Receipt process creates an invoice for each run of the
program. For invoices created based on receipt transactions, you set up invoice consolidation levels for an individual pay
site in the Supplier Site user interface. The invoice levels include Pay Site, Packing Slip, and Receipt.

Other Features
There are several other important features of the Pay on Receipt process.

These features include:

• Creating debit memos: You can choose to automatically generate debit memos for return to supplier
transactions once the Pay on Receipt process creates the invoice.

• Enabling Pay on Receipt for individual purchase orders and releases: You can enable Pay on Receipt for
individual purchase orders and releases by using the Pay On field in the Terms and Conditions page.

• Changing invoice prefixes: You can find Pay on Receipt invoices by using the Find Invoices window in Oracle
Payables to search for any invoice in your system containing the prefix ERS-.

However, you can change this prefix, using the ERS Invoice Number Prefix profile option. For example,
shortening this prefix allows extra spaces for longer packing slip or receipt numbers.

• Supporting self-billing invoices: The Self-Billing Invoice process is an automated invoicing process where the
buying company creates an invoice on behalf of the supplier.

• Enforcing match approval levels to ensure proper payment: Two-, three-, and four-way match approval levels
are enforced by Oracle Payables if you specify two-, three-, or four-way for the supplier site match approval
level.

Related Topics
• Send Pay on Receipt

Print Receipt Traveler Report  

Print Receipt Traveler Report  
The Print Receipt Traveler report facilitates the receiving, inspection, and delivery of goods that you receive within your
organization. After you receive the goods, you can generate and print receipt travelers and attach these tickets to the
goods.

You can enter selection criteria to specify the receipt travelers that you want to print. One receipt traveler prints per
distribution, and each traveler has space for you to record delivery comments.
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You can set up the Print Receipt Traveler report to work in two different ways:

• Automatic generation

• Manual generation

Automatic Generation
If the Print Receipt Traveler option is set to Yes for an organization on the Receiving Parameters page, the receipt
traveler automatically generates when you perform a receipt or a receiving transaction, and when you match unordered
receipts in that organization.

In the Setup and Maintenance work area, use the Manage Receiving Parameters task to access the Receiving
Parameters page.

• Offering: Manufacturing and Supply Chain Materials Management

• Functional Area: Receiving

• Task: Receiving Parameters

Note:  To print the receipt travelers, launch the Print Receipt Traveler report from the Manage Scheduled Process work
area.

Manual Generation
You can manually run the Print Receipt Traveler report from the Manage Scheduled Processes work area (Navigator >
Tools > Scheduled Processes). Select the Print Receipt Traveler Report process, enter process details, and submit
the report for processing. When manually generating the report, you can enter a specific printer to print your receipt
travelers.

This table describes the values that you enter on this page.

Field Entry

Submission
 

Select Print Receipt Traveler Report in the Process Name field.
 

Deliver-to Location
 

Enter a deliver-to location to restrict the report to a specific deliver-to location.
 

Source Organization
 

Enter the organization name for this report.
 

From Receipt
 

Enter the beginning receipt number.
 

To Receipt
 

Enter the ending receipt number.
 

From Item
 

Enter the beginning item number.
 

To Item
 

Enter the ending item number.
 

From Category
 

Enter a beginning item category.
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Field Entry

To Category
 

Enter an ending item category.
 

Ship-to Location
 

Enter a ship-to location to restrict the report to a specific location.
 

Precision
 

Enter the decimal precision for quantities on the report.
 

Related Topics
• Print Receipt Traveler Report

Review Receiving Transactions  

Receiving Transactions Processor  
The Receiving Transaction processor processes your pending or unprocessed receiving transactions. This background
process is triggered every time you create a receipt.

Important features of the Receiving Transaction processor include:

• Processing modes of the Receiving Transaction processor

• Functions of the Receiving Transaction processor

• Running the Receiving Transaction processor

Processing Modes of the Receiving Transaction Processor
The Receiving Transaction processor handles your pending or unprocessed receiving transactions based on the
processing mode that was set up for the profile option. The processing mode option can be set up at the site,
application, responsibility, and user levels.

The processing mode options include:

• Online: In the Online processing mode, the Receiving Transaction processor is called when you save your work.

• Immediate: In the Immediate processing mode, when you save your work, the receiving forms call the
Receiving Transaction processor for the group of transactions that you have entered since you last saved your
work.

Note that this is a specific group of transactions. Transactions belonging to other groups (for example, those
entered by another user in Batch processing mode) aren't included.

• Batch: In the Batch processing mode, the receiving forms insert transaction information into the receiving
interface tables.

These transactions remain in the interface table until you run the Receiving Transaction processor. Oracle
Receiving takes into account all pending transactions, but the application does not update the transaction
history, source documents, and supply information until the transactions are processed.
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You can set Standard Report Submission parameters to run the Receiving Transaction Processor at specified
intervals so that your pending transactions are processed as often as required.

Functions of the Receiving Transaction Processor
The Receiving Transaction processor performs these functions:

• Validates advance shipment notice and advance shipment and billing notice information in the receiving open
interface.

• Derives and defaults values into the receiving interface tables.
For example, if a particular value or field is not received, the receiving open interface tries to derive the value
using defaulting and derivation rules.

• Creates receipt headers for in-transit shipments.

• Creates receipt lines for all receipts.

• Maintains transaction history information.

• Maintains lot and serial transaction history.

• Accrues uninvoiced receipt liabilities.

• Maintains the following purchase order quantities: received quantity, put away quantity, accepted quantity, and
rejected quantity.

• Closes purchase orders for receiving.

• Maintains the following requisition quantities: received quantity and put away quantity.

• Maintains supply information.

• Maintains inventory information (for the Inventory destination type).

• Maintains tax determinants.

• Transmits tax determinants to inventory during put away, corrections, and returns to keep the on-hand
balances accurate.

Running the Receiving Transaction Processor
To run the Receiving Transaction processor:

• Navigate to the Submit Requests window.

• Select Requests in the first field.

• Select Manage Receiving Transactions in the Name field.

• Click Submit to begin the process.

Purge Receiving Interface Tables  

How You Purge the Receiving Interface Tables  
Use the Purge Receiving Interface process to maintain the receiving interface.
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Receipts that are successfully imported are usually purged automatically. However, some receipt rows may remain in the
interface and accumulate over time. The Purge Receiving Interface process purges records that are in error, or in error
and pending statuses.

Important features of the Purge Receiving Interface process include:

• Running the Purge Receiving Interface process

• Parameters of the Purge Receiving Interface process

Running the Purge Receiving Interface Process
To run the Purge Receiving Interface process:

1. Navigate to the Scheduled Processes work area (Navigator > Tools >  Scheduled Processes).
2. Click Schedule New Process.
3. Select Purge Receiving Interface in the Name field and click OK.
4. Enter process parameters.
5. Click Submit to begin the process.

Parameters of the Purge Receiving Interface Process
Select options for the parameters of the Purge Receiving Interface process that are shown in the following table.

Parameter Description

Purge Data Before
 

Purges all the records before the date selected.
 

Status
 

The default status is error. You can also select and purge records that are in both error and pending
statuses.
 

Note:  You can run the Purge Receiving Interface process only if you have the required security privileges.

Related Topics
• Purge Receiving Interface

Receiving Document Activity Report  

Receiving Document Activity Report  
The Receiving Document Activity report provides diagnostic information about your application. This report collects
information about a receiving document and the receipts and transactions recorded against the document.

Here's how to run the Receiving Document activity report:

1. Select the drop-down arrow next to your ID in the upper right to open the Settings and Actions menu.
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2. Click the Run Diagnostic Tests link.
3. On the Diagnostics dashboard, in the Search for Tests section of the page, enter Receiving Document

Activity in the Test Name field and click Search.
4. Select the test from the Search Results by clicking the check box next to the report name.
5. Click the Add to Run button. This takes you to the Choose Tests to Run and Supply Inputs page.
6. In the Run Tests section of the page, click the Required Input Values Validated check box to enter the report

parameters.
7. In the Input Parameters window, the Document Type defaults to PO. Other available document types include:

◦ Purchase order

◦ Transfer order

◦ In-transit shipment

◦ RMA

8. You must also enter either a document number or receipt number to run the report. Select the check box next
to either the Document Number or Receipt Number fields to activate those fields for entry.

9. Click OK to close the Input Parameters window.
10. Back on the Diagnostics dashboard, in the Run Tests section of the page, click the Run button.
11. You receive a confirmation message stating that the test run has been submitted. Click OK.
12. In the Diagnostics Test Run Status section of the page, click the Display Latest Test Run Status Information

icon (arrows) to refresh the list of test runs. View the progress of your run.
13. Click the Report icon to view your diagnostic test report.
14. View your diagnostic report output.
15. Go to the Error section of the diagnostic report and find any error text. Then, make the appropriate corrections.

For example, if you see a lot or serial validation error, look at the lot and serial numbers entered in the receiving
transaction and make corrections accordingly.

Note:  You must be logged in as an administrator user or as a user who's granted one of the diagnostic roles to run
this report.

FAQs for Receiving Processes and Reports  

What's the difference between inventory and expense transfer
orders for receiving processing?  
For expense destination transfer orders, returns aren't allowed, serial and lot numbers aren't tracked in receiving, and
no corresponding inventory transactions are created when you perform a put away in receiving.

All other processing of receiving transactions is the same for expense and inventory destination transfer orders. This
includes processing for the creation of the inbound shipment and processing for the receive, put away, inspect, and
correct transactions.
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14  Brazil Inbound Shipments

Inbound Shipments for Brazil  
Oracle Receiving is part of a comprehensive process flow to ensure fiscal documents are compliant with the
requirements of receiving items in a Brazil inventory organization.

We use fiscal documents for Brazil inventory organizations to document trade between suppliers and customers. The
fiscal document serves as a bill of lading to detail the quantity of items transported from the supplier to the customer. It
also serves as a proxy invoice from the supplier that documents the material costs, supplier charges, and taxes payable
by the customer.

This topic covers these features for Brazil inbound shipments:

• Inbound process flow compliance

• Receiving tasks for Brazil

Inbound Process Flow Compliance
The inbound process flow ensures compliance with Brazilian fiscal document processing requirements. The fiscal
document validation process is the key process in the fiscal document management system. A positively validated fiscal
document assures the authorities that the parties, items, and taxes applicable to the receipt are correct.

The validation process ensures that:

• The parties in the receipt transactions are duly registered for fiscal purposes.

• The items and their prices correspond to that on the purchase order.

• Federal, state, and municipal taxes reported in the fiscal document for received goods have been correctly
calculated.

The following apply when Fiscal Document Capture is implemented:

• Once the fiscal document is approved, Fiscal Document Capture populates the receipt interface with the details
required to create a receipt. This enables Receiving to create a formal receipt.

Note:  A receipt is not created in Receiving until the fiscal document validation process is completed.

• Receipt creation happens through Fiscal Document Capture directly in Receiving, without any manual
intervention at the end of receiving. You cannot create a receipt through the Receiving or Self-Service Receiving
user interface.

• Once a receipt is created, you cannot update the receipt details in any way.

• You cannot create unordered receipts in the Brazil organization.

• You cannot update the fiscal document number and receipt quantities directly in Receiving. The Fiscal
Document Capture system is the source of truth for item receipt quantities.
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Receiving Tasks for Brazil
The following actions are available from the Receipts work area for managing Brazil inbound shipment transactions that
are enabled for fiscal document capture:

• Inspect Receipts

• Put Away Receipts

Note:  You cannot update the Quantity field for Brazil organizations.

• Return Receipts

Note:  You can only return to supplier for Brazil organizations.

• Review Receipt Interface

• Quality Inspection Results

When Oracle Fiscal Document Capture is implemented, you can view inbound shipments on the Manage Inbound
Shipments page. However, you cannot edit any of the details for the shipment or shipment line.

Since a receipt is created only after the fiscal document is validated, you cannot correct the received quantity.

For more information about Brazil fiscal documents, see the Oracle Fusion Cloud SCM: Using Fiscal Document Capture
guide.

Related Topics
• Steps for Fiscal Document Compliance

• Manage Fiscal Documents

• Overview of Fiscal Document Capture

• Receiving Parameters for Brazil Organizations

Steps for Fiscal Document Compliance  
Oracle Receiving performs many steps to support inbound logistics for Brazil organizations.

These steps include:

• Captures additional fiscal document details

• Prevents duplication and update of receipts

• Validates fiscal document lines

• Handles lines that fail or pass receiving validation

• Does not trigger pay on receipt

• Transfers transactions from Receiving to Costing
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Captures Additional Fiscal Document Details
Receipt lines store the following additional attributes for a Brazil organization: fiscal document header ID, fiscal
document access key number, fiscal document line ID, reference fiscal document header ID, reference fiscal document
line ID, and reference fiscal document access key number.

Prevents Duplication and Update of Receipts
Receiving prevents duplication and update of receipts for Brazil organizations.

• Receiving calls an API to determine whether or not the organization is a Brazil inventory organization. The API
checks if the fiscal document generation feature is enabled for the billing business unit.

• Receipt creation happens through the Receiving open interface only by Fiscal Document Capture. You cannot
create a receipt through the Receiving work area or Self-Service Receiving.

• After the receipt is created, you cannot update the receipt.

Validates Fiscal Document Lines
Fiscal Document Capture sends only the lines that are successfully validated to Receiving for receipt creation. Receiving
then performs all the validations that it performs for any organization, as well as additional validations for Brazil
organizations, before creating the receipt.

Handles Lines That Fail or Pass Receiving Validation
A single receipt is created for a single fiscal document, and a receipt is created in Receiving only if all lines are validated
successfully.

For example, if 100 lines are validated in Fiscal Document Capture and sent to Receiving, but 2 of the 100 lines fail
validation in Receiving, then the receipt isn't created. The failure is communicated back to Fiscal Document Capture.

However, if all lines are validated successfully, Receiving automatically communicates the receipt number and receipt
line number back to Fiscal Document Capture without manual intervention.

Does Not Trigger Pay on Receipt
For a Brazil organization, Receiving ensures that the Pay on Receipt process isn't triggered for a Brazil organization.
Fiscal Document Capture directly obtains the invoice details based on the invoice's completion status.

Transfers Transactions From Receiving to Costing
The process to send receipt details to Oracle Cost Management includes additional fiscal document attributes such as:

• Fiscal document header ID

• Fiscal document line ID

• Fiscal document access key number

For more information about Brazil fiscal documents, see the Oracle Fusion Cloud SCM: Using Fiscal Document Capture
guide.
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Related Topics
• Inbound Shipments for Brazil

• Overview of Fiscal Document Capture

• Manage Fiscal Documents
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15  Outside Processing Services

Overview of Outside Processing  
Outside processing is a business process where one or more operations of a work order are outsourced to a supplier
who provides specialized manufacturing services.

These services may vary depending on the nature of the industry.

Outside processing is often adopted as a strategic alternative to in-house manufacturing for the following reasons:

• To lower manufacturing costs due to production costs

• To leverage state of the art manufacturing technology

• To increase capacity to overcome production bottlenecks

• To focus on core competencies

Here's a figure which explains a business flow where three operations are required to complete
a work order. Operation 10 which is machining, followed by operation 20 which is plating, and
operation 30 which is assembly. Operation 20 is a supplier operation performed by outside processing.

• An Original Equipment Manufacturer (OEM) performs the first operation in-house and ships the machined
parts to a supplier for plating.

• The supplier performs the plating operation and sends the plated parts to the Original Equipment
Manufacturer (OEM).

• The OEM receives the plated parts and pays the supplier for performing the value added services.

In the entire process, the OEM retains the ownership of the goods that are sent to and received back from the supplier.

Note:  The outside processing flow is supported for both discrete and process manufacturing.
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Outside Processing in Receiving  
In outside processing, one or more manufacturing operations in a work order are outsourced to external providers. The
Original Equipment Manufacturer (OEM) handles selective manufacturing operations in house and outsources other
manufacturing operations to one or more service providers.

Outside processing improves operational efficiency by:

• Providing visibility into supply chain functions

• Reducing manual intervention

• Improving management of demand and supply side change

• Providing better insight into outside processing costs

The outside processing flow begins and ends within the Oracle Fusion Cloud Manufacturing solution. Manufacturing
sends the shipment lines to Oracle Shipping for processing. From Shipping, the lines are packed and shipped to the
supplier. The supplier then performs their services on the goods and sends the goods back to the OEM. The OEM
receives the goods in Oracle Receiving and delivers the processed items back to Manufacturing. For more information
about the outside processing business process flow, see the Oracle Fusion Cloud SCM: Using Manufacturing guide. For
information about outside processing in Shipping, see the Oracle Fusion Cloud SCM: Using Shipping guide.

The following figure shows a high-level overview of the outside processing flow as it relates to receiving and shipping.

Explanation of callouts:

1. Manufacturing sends shipment lines for outside processing to Shipping.
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2. Shipment lines are imported into Shipping for packing and shipping to a supplier or manufacturing partner for
outside processing.

3. The supplier or manufacturing partner receives the items and performs the agreed upon outside processing
services.

4. After the supplier or manufacturing partner has completed service on the items, the items are sent back to the
original manufacturer.

5. Outside processing items are received back from the supplier or manufacturing partner in Receiving and
delivered to the original manufacturer to progress the work order to completion.

Throughout the entire process, the original manufacturer retains ownership of the goods that are sent to and received
back from the supplier or manufacturing partner. The work order and purchase order information follow all the steps of
the outside processing flow.

Note:  Manufacturing calls Oracle Supply Chain Orchestration to enable the shipping of partially finished assemblies
by creating shipment requests. The supply chain orchestration process tracks and monitors supply orders for
outsourced manufacturing operations. For more information about outside processing in Supply Chain Orchestration,
see the Oracle Fusion Cloud SCM: Using Oracle Supply Chain Orchestration guide.

You must deliver Inventory items received from the supplier or manufacturing partner to manufacturing after outside
processing to progress a work order to completion. When performing the put away to manufacturing, you're not
required to enter subinventory or locator information because the destination type on the shipment lines is work
order. After the put away transaction is processed, existing events inform manufacturing that the items are ready to be
consumed. Because the custody of the goods is no longer with Receiving, Manufacturing must initiate corrections or
returns.

Use the Put Away Receipts page to navigate to the Put Away Lines page to receive and deliver outside processing
items to manufacturing.

For consecutive supplier operations, Receiving automates the delivery of goods along with the receipt using an
advanced shipment notice for the purchase orders. The goods move from one supplier to the next directly until the last
supplier who ships the goods to the original manufacturer after the final supplier operation. This automation progresses
the purchase orders and work orders to completion. You can configure the receipt traveler report to include work order
and end assembly information.

The job roles associated with outside processing in Receiving are warehouse manager and receiving agent. Using
outside processing in Receiving, you can record completed quantities at supplier operations after goods are received
and delivered to manufacturing.

Integration with Oracle Fusion Cloud Global Trade Management is available for outside processing. However, integration
with Oracle Fusion Cloud Transportation Management isn't available for outside processing.

Related Topics
• Overview of Outside Processing

• Examples of Receiving and Putting Away Outside Processing Purchase Order Lines

• Examples of Receiving and Putting Away Purchase Order Lines with In-House and External Ship-To
Destinations

• Use Supply Chain Orchestration in Your Back-to-Back Flows
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Examples of Receiving and Putting Away Outside
Processing Purchase Order Lines  
The following scenarios provide examples of receipt and put away of purchase order lines when using outside
processing.

Receipt and Put Away of Outside Processing Purchase Order Lines with a
Shop Floor Destination
In this scenario, an operator within Oracle Fusion Cloud Manufacturing generates a work order to manufacture an
assembly item with multiple operations, and one of the operations is a supplier operation.

The prerequisites before processing the work order are:

• Oracle Supply Chain Orchestration creates a purchase requisition for the required outside processing of the
work order's supplier operation

• Oracle Purchasing approves the requisition and generates a standard purchase order for outside processing of
the partially finished assembly for the work order

• The work order progresses to complete the first operation for the full quantity.

• Manufacturing calls on the supply chain orchestration process to enable the shipping of the partially finished
assembly by creating shipment requests. The supply chain orchestration process also communicates the
shipment request details, including the work order details and the purchase order details to Oracle Shipping.

• A shipping user confirms the shipment of the partially finished assembly to the outside processing supplier
within Shipping.

When the outside processing service is completed by the supplier, the supplier sends the goods back to the original
manufacturer. After reviewing the documents that accompany the goods, your receiving agent notices the items have
arrived with partially finished assembly. Using the purchase order to query the expected shipment lines on the Receive
Expected Shipment Lines page, the receiving agent identifies the work order-related purchase order line and initiates
receipt of the goods against that line. Quantity and other details are entered to complete the receipt of the line. The
receiving agent then initiates the put away of the purchase order line.

Subsequently, the purchase order line is recognized as outside processing with a shop floor destination. The
subinventory and locator attributes are automatically disabled because they aren't relevant to outside processing lines.
A call is sent to the Manufacturing application programming interface to deliver the material to the work order.

The work order is now searchable within Manufacturing to verify the supplier operation has completed. For more
information about work orders, see the Oracle Fusion Cloud SCM: Using Manufacturing guide.

Direct Receipt of Purchase Order Lines with a Shop Floor Destination
In this example, the criteria is the same as the first scenario above except that Procurement generates an outside
processing purchase order of the partially finished assembly for the work order with a direct routing.
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Disallow Return of Delivered Purchase Order Lines with a Shop Floor
Destination
In this example, the criteria is the same as the first scenario above except that the partially finished assembly has
already been received against the purchase order and delivered to the work order. The warehouse manager or receiving
agent notices that the delivered outside processing lines aren't available in the results. No results appear because the
delivered outside processing lines aren't eligible for returns within Oracle Receiving. You must initiate returns on goods
delivered for outside processing within Manufacturing.

Disallow Correction of Delivered Purchase Order Lines with a Shop Floor
Destination
In this example, the criteria is the same as the first scenario above except that the partially finished assembly has
already been received against the purchase order and delivered to the work order. The warehouse manager or receiving
agent notices that the delivered outside processing lines aren't available in the results. No results appear because the
delivered outside processing lines aren't eligible for corrections from within Receiving. You must initiate corrections on
goods delivered for outside processing from within Manufacturing.

Examples of Receiving and Putting Away Purchase Order
Lines with In-House and External Ship-To Destinations  
The following scenarios provide examples of receipt and put away of outside processing purchase order lines with a
shop flow destination and an external ship-to location.

Receipt and Put Away of Outside Processing Purchase Order Lines with a
Shop Floor Destination and an External Ship-To Location
In this scenario, an operator within Oracle Fusion Cloud Manufacturing generates a work order to manufacture an
assembly item with three operations, and two of the operations (second and third) are supplier operations at different
suppliers. The prerequisites before you can process the work order are:

• Oracle Supply Chain Orchestration creates a purchase requisition for the outside processing of the work order's
supplier operation with the first supplier. The ship-to location is external, corresponding to the second supplier
for the third operation

• Oracle Purchasing approves the requisition and generates a standard purchase order for outside processing of
the partially finished assembly at the first supplier for the work order with a direct routing. Also, Procurement
approves a requisition and generates a purchase order for outside processing of the partially finished assembly
at the second supplier for the work order with direct routing.

• The work order progresses to complete the first operation for the full quantity.

• Manufacturing calls on the supply chain orchestration process to ship the partially finished assembly by
creating shipment requests. The supply chain orchestration process also communicates the shipment request
details, including the work order details and the purchase order details, to Oracle Shipping.

• A shipping user confirms from within Oracle Shipping the shipment of the partially finished assembly to the
first outside processing supplier.

87



Oracle Fusion Cloud SCM
Using Receiving

Chapter 15
Outside Processing Services

Oracle Receiving then:

• Imports an advance shipment notice from the first supplier for shipping the partially finished assembly to the
second supplier. This shipment is recognized as an outside processing purchase order line with an external
ship-to location.

• Automatically completes the receipt and delivery of the purchase order line to the shop floor against the work
order.

The work order is now available for searching within Manufacturing to verify that the first supplier operation has
completed.

Disallow Manual Receiving Purchase Order Lines with a Shop Floor
Destination and an External Ship-To Location
In this example, the criteria is the same as the scenario above except that when the warehouse manager or receiving
agent query the purchase order lines with a ship-to location, no results are retrieved. This is because purchase order
lines for outside processing with an external ship-to location aren't available for selecting as the matching document.
Match the unordered receipt to an outside processing purchase order line with an external ship-to location.

Outside Processing Services  

Can I initiate returns and corrections on goods delivered from
outside processing suppliers within Oracle Receiving?  
No. You must initiate returns and corrections for goods delivered from outside processing suppliers within the Oracle
Fusion Cloud Manufacturing solution.

Can I return goods delivered from outside processing suppliers to
inventory?  
No. You must return goods delivered from outside processing suppliers directly to manufacturing.
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16  Communicate Receiving Messages and
Updates

Create ASNs and ASBNs  

Overview of Creating ASNs and ASBNs  
In this activity, suppliers can create ASNs (advance shipment notices) and ASBNs (advance shipment billing notices)
when a shipment is ready.

Upon submission of the ASN or ASBN, a notification is sent to the buyer. For ASBNs, the supplier also enters billing
details, such as the invoice number, invoice date, and invoice amount.

Suppliers can:

• Search for purchase order lines and create ASNs and ASBNs

• Enter shipment details for the ASN or ASBN

• Enter lot or serial information

• Record nested packing units

• Enter billing information for ASBNs

• Edit an ASN or ASBN line

• Split a shipment line

Packing Slip Details for ASNs and ASBNs  
On the Create ASN and Create ASBN pages, you can enter packing slip values at both the header and line levels.

For example, you can create an ASN and assign a packing slip at the header level. Then, you may choose to split the
ASN into more than one line and assign different packing slip information at each line level. The value that you enter for
the packing slip at the header level defaults at the receipt header level when receiving material using an ASN. The value
for the packing slip at the line level doesn't default at the receipt line level.

Neither of these packing slip values appear directly on the Receive Expected Shipments page when receiving a purchase
order that's associated with an ASN or ASBN. From the Receive Expected Shipments page, click an ASN or ASBN
number to view the header and line level packing slip details.

Note:  The same is true for the Manage Inbound Shipments page. You must click the ASN or ASBN to view the
packing slip details.
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FAQs for Creating ASNs and ASBNs  

What happens if I am creating an ASN or ASBN for lines that are lot or serial
controlled?  
You must specify lot numbers and serial numbers.

If the complete receipt line corresponds to a single lot or serial range, then you can update the table. If not, then you can
select the Record Lots and Serial Numbers item from the Actions menu to enter new lot and serial numbers.

How can I record nested packing units?  
Select the Record Nested Packing Units item from the Actions menu.

How can I split a purchase order line?  
Select the purchase order line and then select the Split Line item from the Actions menu. A duplicate line is added to the
table. You can then edit the original and new line.

Can I create ASNs and ASBNs with consigned items?  
Yes, you can create ASNs with consigned items. However, you cannot create ASBNs with consigned items.

Can I create an ASN that contains both consigned and nonconsigned items?  
Yes, when creating an ASN for the consignment order, you can create a single ASN that includes both consigned and
nonconsigned items.

Manage Advance Shipment Notices  

Overview of Managing ASNs and ASBNs  
In this activity, supplier customer service representatives can view, edit, and cancel ASNs (advance shipment notices)
and ASBNs (advance shipment billing notices) through the Manage Shipments and Edit Shipments pages.

They can select an individual shipment on the Manage Inbound Shipments page to be transferred to the Edit Shipment
page. The Supplier Customer Service Representative can use the Edit Shipment page to work on all shipment lines in a
shipment at one time, or drill down into a specific shipment line on the Edit Shipment Details page.
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FAQs for Managing ASNs and ASBNs  

Why can't I cancel the ASN or ASBN?  
You can't cancel an advance shipment notice (ASN) or advance shipment billing notice (ASBN) if the buying company
has received any of the associated lines. In addition, for ASBNs, you can't cancel the ASBN if the buying company has
paid the invoice.

What happens if I cancel an ASN or ASBN?  
Canceling sends a notification to the buyer. Canceling an ASBN also cancels both the shipment notice and the
corresponding invoice that was issued in the buyer's payables system.

Note:  You can't undo the cancellation of a shipment.

Manage Receipt Advice  

Receipt Advice Process  
The Receipt Advice scheduled process transmits information regarding the expected inbound shipment of goods from
an outsourcer (Logistics Service Provider's Customer) to a Logistics Service Provider (LSP) to expect inbound goods.

Receipt Advice Information
The receipt advice contains all necessary information for the physical material receipt and material reconciliation
such as item information, quantity expected date of receipt, and expected location of receipt. The receipt advice also
contains special instructions such as inspection, labeling, and so forth.

Advance Shipment Notice
The receipt advice might or might not be accompanied by an ASN. The receipt advice by itself provides enough
information to perform the receipt of goods in the warehouse.
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Send Receipt Confirmation  

Send Receipt Confirmation Process  
The Send Receipt Confirmation job interfaces receiving transactions performed against RMAs to Oracle Order
Management. Return orders that are in a status of Awaiting Receiving are progressed to other statuses based on the
Oracle Order Management orchestration process.

Related Topics
• Send Receipt Confirmation

Send Receipt Confirmation Troubleshooting for RMA Receipts  
Let's look at an overview of the process and data flows for RMA receipts, along with troubleshooting for the RMA
process flow.

Process Flow for RMA Receipts
Here's the process flow for RMA receipts:

1. Create a return order in Oracle Distributed Order Orchestration using the Return for Credit and Return Item
return type.

2. Using the Manage Inbound Shipments task or Receive Expected Shipments task, search for the RMA in the
destination inventory organization and create a receipt.

3. Run the Send Receipt Confirmation scheduled process to interface the receipt data for the RMA to Distributed
Order Orchestration. This processes the RMA further and creates a credit memo.

Data Flow for RMA Receipts
When RMA orders are booked and in the Awaiting Receiving status, the application creates records in the
RCV_SHIPMENT_HEADERS and RCV_SHIPMENT_LINES tables, which we refer to as RMA receipt advices.

After receiving the RMA, the application creates another set of records in the RCV_SHIPMENT_HEADERS and
RCV_SHIPMENT_LINES tables that contain the actual receipt data related to the RMA.

Send Receipt Confirmation Scheduled Process Inputs
Here are the input parameters passed for the Send Receipt Confirmation scheduled process:

• Organization: Inventory organization where the RMA receipt is created

• Source System: External or Oracle source system (Oracle Order Orchestration and Planning)

• Source Document Number: RMA number

• Receipt: Receipt number created in Receiving
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Troubleshooting the RMA Process Flow
This table presents some common issues that you could encounter with the RMA process flow.

Issue Solution

After running the Send Receipt
Confirmation process by passing the
Organization and Source System
parameters, the process ends with this
error:
 
Transaction has to be undone, number
of lines in error
 

You may receive this error if there are too many receipts that need interfacing to Distributed Order
Orchestration.
 
The Send Receipt Confirmation scheduled process sends the data from Receiving to Distributed
Order Orchestration one fulfillment line at a time. In the case of this error, there are too many lines. If
these lines include lot and serial numbers, the total size of the data sent by Receiving to Distributed
Order Orchestration could exceed a certain value, and the program can't handle it.
 
To solve this, you can regularly schedule the job so that the lines are communicated immediately.
 

Can't cancel RMA orders in Order
Management
 

You can't cancel RMA orders if the RMA has already been delivered. If a RMA is received, but not
delivered, you can correct or return the RMA receipt to cancel the RMA.
 

Unable to return or correct an RMA receipt
 

You can't return or correct RMA receipts after they have been delivered to inventory. Check if the RMA
has been delivered by searching for the RMA on the Review Completed Transactions page.
 

Related Topics
• Send Receipt Confirmation

Upload ASN or ASBN  

ASN or ASBN Uploads  
If you have a large volume of advance shipment notices (ASNs) or advance shipment billing notices (ASBNs), you can
create a spreadsheet containing shipment details and upload it into your buying company's system. You can create
shipment notices offline, and then upload the file.

The supplier customer service representative can upload a tab-separated file for creating an ASN or ASBN. You can
navigate here by selecting the Upload ASN or ASBN link in the task pane of the Oracle Supplier Portal.

93

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=u30230908


Oracle Fusion Cloud SCM
Using Receiving

Chapter 16
Communicate Receiving Messages and Updates

94



Oracle Fusion Cloud SCM
Using Receiving

Chapter 17
External System Integrations

17  External System Integrations

External System Receipt Integration Processes  
You can communicate a receipt advice for expected shipment lines to execution partners.

Use the following processes to interface with external systems:

• Generate Receipt Advice

• Manage Receiving Transactions

• Generate Changed Receipt Advice

Generate Receipt Advice
Use this process to notify an external system about a receipt advice ready to be interfaced.

Manage Receiving Transactions
This process validates and processes the receipt transactions received into open interfaces automatically without user
intervention. This process also publishes receipt advice events after the creation of a new ASN or ASBN.

Generate Changed Receipt Advice
This process notifies an external system about changes to an already interfaced receipt advice.

External System Receipt Integration Statuses  
Use external system receipt integration statuses to search for externally controlled receipt lines in a specific status.
These statuses are helpful when integrating with external systems, such as is the case when interfacing with contract
manufacturing.

External system receipt integration statuses include:

• Ready to interface

• Interfaced

Note:  The integration status is not available by default. Select the integration status field from the View menu on
available pages such as Receive Expected Shipment Lines and Manage Inbound Shipments.
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Receiving Transaction Interface  
Use the Receiving Transaction Interface to create receipts or advance shipment notices (ASN) to process receiving
transactions through the Receiving Open Interface.

Run the Receiving Transaction Interface by selecting the Review Receipts Interface link from the Tasks pane of the
Inventory Management work area.

Before launching this interface, you must:

• Load import data to the Receiving Transaction Interface tables (RCV_HEADERS_INTERFACE,
RCV_TRANSACTIONS_INTERFACE, INV_TRANSACTION_LOTS_INTERFACE,
INV_SERIAL_NUMBERS_INTERFACE, and INV_LPN_INTERFACE). For more information on each interface table,
see Oracle Enterprise Repository for Oracle Fusion Cloud Applications.

You can load data to interface tables using predefined templates and the Load Interface File for Import
scheduled process, which are both part of the External Data Integration Services for Oracle Cloud feature. For
other implementations, optionally use this feature only if you have SFTP configured for it.

• Establish parent-child relationships for the following Receiving Transaction Interface tables:

◦ RCV_HEADERS_INTERFACE: contains receipt header and shipment header information.

◦ RCV_TRANSACTIONS_INTERFACE: contains receipt line information.

◦ INV_TRANSACTION_LOTS_INTERFACE: contains lot information.

◦ INV_SERIAL_NUMBERS_INTERFACE: contains serial information.

◦ INV_LPN_INTERFACE: contains packing unit information.

Related Topics

FAQs for External System Integrations  

How can I interface receipt lines to an external system manually?  
Use the Generate Receipt Advice page to schedule a receipt advice to interface receipt lines to external systems.

To initiate this request, select the Generate Receipt Advice task from the task panel of the Inventory Management work
area. Then, fill out the applicable fields on the Generate Receipt Advice page.
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How can I process pending inbound receipt confirmations or
errors?  
For pending inbound receipt confirmations or errors, from the Receipts task list in the Inventory Management work
area, click Review Receipts Interface. Edit and upload the data.

To do this task, you need an Excel add-in. From the Navigator, click Tools > Download Desktop Integration to install
the add-in.

How can I process pending outbound receipt advice transactions? 

For pending outbound receipt advice transactions, open the scheduled process interface by selecting Navigator  >
Tools > Scheduled Processes. Search for, and run Generate Receipt Advice.

What's an execution partner?  
An external company that provides execution services like a logistics service provider or contract manufacturer.
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18  Self-Service Receipts

Overview  

Overview of Self-Service Receipts  
You can use self-service receipts to request and directly receive goods.

For example, an employee requests a new office chair and enters a request in the Oracle Fusion Cloud Procurement
application. The purchasing agent generates a purchase order and sets it up with a receipt routing of direct delivery.
The supplier then fills the order and delivers the chair directly to the requester. Upon receipt, the requester updates the
application to indicate that the requested item was received.

There are two major UI pages for Self-Service Receiving:

• Receive Items page - use for creating receipts

• Manage Receipts page - use for viewing, returning, and correcting receipts

Oracle Procurement is essential for the self-service receiving process flow. However, any inbound inventory transaction
is classified as a part of Oracle Receiving regardless of the user's business role.

To access Self-Service Receipts, select My Receipts from the Procurement work area.

Related Topics
• Enable Self-Service Receiving on the Behalf of Others

Enable Self-Service Receiving on the Behalf of Others  
You can create receipts for requisitions when you're not the requester or preparer.

To enable users to create self-service receipts on the behalf of others, complete these steps:

1. Click Navigator > Tools > Security Console.
2. Click the Create Role button.
3. Enter a value for the Role Name.

For example, enter Self Service Receiving All Requisitions.
4. Enter a value for the Role Code.

For example, enter SELF_SERVICE_RECEIVING_ALL_JOB.
5. Select SCM Job Roles as the Role Category.
6. Enter the Role Description.

For example, enter Job role to receive self-service receipts for all procurement requesters.
7. Click Next.
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8. Click Add Function Security Policy.
9. Add Function Security Policy:

◦ Function Security Policy: Create Self-Service All Requisition Receiving Receipt

◦ Description: Allows creation of self-service receipts by any other person apart from the requisition
requester or preparer

10. Click the Add Privilege to Role button.
11. Click Next.
12. On the User's Step, click the Add User button.
13. Select the appropriate user to add to the newly created job role.
14. Click the Add User to Role button.
15. Click the Save and Close button on the last step of the process.

FAQs for Self-Servce Receipts  

What functions can a requester perform within Self-Service Receiving?  
A requester can perform these actions in Self-Service Receiving:

• Receive Items: create a receipt against requisitions, purchase orders, internal orders, and ASNs.

• View Receipts: locate and view details for existing receipts.

• Return Items: return quantity-based received items to the supplier. This includes full or partial quantities.

• Correct Receipts: modify an existing receipt quantity in case of any errors.

Note:  You can only return quantity-based received lines through Self-Service Receiving.

How does the receipt routing affect what receipts I see on the My Receipts pages in
Self-Service Receiving?  
For transactions to appear on the My Receipts pages, purchase orders must have their Receipt Routing value set to
Direct Delivery. To receive a purchase order with a Standard Delivery receipt routing, you must use the Receive Expected
Shipments page in Oracle Receiving.

What receiving line statuses can I view on the My Receipts pages?  
The receiving line must be in Open or Partially Received status to view it on the My Receipts pages in Self-Service
Receiving.

What's the criteria for a purchase order to appear on the My Receipts pages in Self-
Service Receiving?  
Self-Service Receiving supports requested purchase orders. For transactions to appear on the My Receipts pages, these
must be true:

• The purchase order must have its Receipt Routing value set to Direct Delivery.

• The receiving line must be in Open or Partially Received status. The purchase order can't have a status of
Closed for Receiving. It should be a 3-way match purchase order.

• The Requester field on the distribution must be populated.
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Note:  The purchase order distributions must have a Deliver to Person populated. This field defaults from
the requester on the backing requisition, if there is one.

In addition, keep these in mind when using Self-Service Receiving:

• When searching for a purchase order without a backing requisition, leave the Entered By field in the search
criteria blank.

• If you're searching for items to receive using the Requisition Business Unit and the list doesn't show any
values, you should have requisition business unit data access through the Procurement Requester role.

• You must be assigned a role that includes the Create Self-Service Receiving Receipt privilege. You should also
be authorized to do one of the following:

◦ Receive on behalf of others

◦ Be either the requester or preparer of the requisitions

◦ Be the deliver to person on the purchase order

• The business unit should not be Fiscal Document Generation and Fiscal Document Capture enabled. These
types of business units are created for Brazil. If they're enabled, documents must go through Fiscal Document
Capture. You can't create a receipt directly from My Receipts or from Oracle Inventory Management with fiscal
documents.

Why doesn't Self-Service Receiving have the Add to Receipt button like warehouse
receiving?  
The Add to Receipts functionality is only available within warehouse receiving.

A warehouse manager or receiving agent has the information to identify how receipts should be grouped. In fact,
a warehouse user can even enter a receipt number manually. In warehouse receiving, the user can create a receipt
for purchase orders that belong to a single supplier at a time. Also, receipts can be created for only one inventory
organization. Because of that, the warehouse user needs the ability to access previously created receipts and add to
them.

An employee who accesses Self-Service Receiving doesn't have the necessary information regarding how receipts are
grouped. More importantly, a requester can receive purchase orders belonging to different suppliers and destined for
different inventory organizations. That's why Self-Service Receiving organizes the lines being received and creates the
receipts based on different grouping criteria. Self-Service Receiving always creates new receipts.

Why doesn't Self-Service Receiving let me view receipts created by other people?  
Self-Service receiving can only be processed by the requester. If you need to receive all purchase orders, you should use
the standard Oracle Receiving pages for the Receive Load flow.

How should I set up receipt number parameters for Self-Service Receiving?  
For Self-Service Receiving, use the Manage Receiving Parameters task to set up your receipt number receiving
parameters.

In the Setup and Maintenance work area, go to the Manage Receiving Parameters task:

• Offering: Manufacturing and Supply Chain Materials Management

• Functional Area: Receiving
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• Task: Manage Receiving Parameters

In the Receipt Number Receiving Parameters section of the page, select these values for Self-Service Receiving:

Field Value

Generation
 

Automatic
 

Type
 

Numeric
 

Receive Item  

Overview of Receive Items  
Procurement requesters can create receipts against requisitions, purchase orders, and advance shipment notices.

To create self-service receipts, select Navigator > Procurement > My Receipts.

Note:  You can also create receipts for requisitions when you're not the requester or preparer.

Related Topics
• Enable Self-Service Receiving on the Behalf of Others

Create a Self-Service Receipt  

Create a Self-Service Receipt  
This example demonstrates how to create a self-service receipt. You can create self-service receipts for items that you
purchase for yourself that get delivered to your desk such as paper, pens, and other office supplies.

Watch video
 

The following table summarizes key decisions for this scenario.

Decisions to Consider In this Example

What's the purchase order number?
 

1004213
 

What's the number of items received?
 

1
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Decisions to Consider In this Example

Should I populate the receipt by default?
 

No
 

What's the waybill number?
 

408819845
 

What's the packing slip number?
 

PS1009675
 

For this scenario, you will:

1. Create a self-service receipt.
2. Verify that the newly created receipt exists.

You have already created the purchase order 1004213 to buy a case for your laptop.

Create a Self-Service Receipt

1. Click Navigator > Procurement > My Receipts.

This takes you to the Receive Items page where you can search for the purchase order that you used to buy the
laptop case and start the self-service receipt process.

2. On the Receive Items page, in the Purchase Order field, enter 1004213.
3. Click Search.
4. In the Search Results section, select the line containing your purchase order 1004213.
5. Click Receive.

This takes you to the Create Receipts page where you can enter the number of items received, waybill, and
packing slip number to finalize the receipt.

6. On the Create Receipts page, complete the fields, as shown in this table.

Field Value

Quantity
 

1
 

Waybill
 

408819845
 

Packing Slip
 

PS1009675
 

Note:  You can use the Show Receipt Quantity button to optionally populate the Quantity field. But, let's
enter the quantity manually.

7. Click Submit.

Once you click the Submit button, you've created your receipt and you'll receive a confirmation message. The
receipt number displays on the confirmation message.

8. Click OK to close the confirmation window.
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Verify the New Receipt
Now you can verify that your receipt was created by searching for it on the Manage Receipts page.

1. In the task pane, click Manage Receipts.

On the Manage Receipts page, you can enter search criteria to filter your search, or just click the Search button.
Let's enter the receipt number.

2. In the Receipt field, enter 9288.
3. Click Search.
4. In the Search Results table, click receipt 9288 to view the receipt that you just created.

This takes you to the Receipt page where you can check the details of your receipt.

Search My Receipts  
To complete a search from My Receipts in Self-Service Receiving, complete these steps:

1. Navigate to the Receive Items page: Navigator > Procurement > My Receipts
2. On the Receive Items page, enter your search criteria.

Available search fields are shown in this table:

Field Description

Requester
 

Matches the requester of the requisition.
 

Entered By
 

Matches the entered by of the requisition.
 

Requisition
 

Requisition number.
 

Items Due
 

Use this dropdown list to filter purchase order or transfer order line items that are due in a certain
time frame (for example, last 60 days, last 30 days, last 7 days, last 3 days, Yesterday, Today, Next 3
days, Next 7 days, and Any Time).
 
The due date is calculated based on the promised date or need-by date for a purchase order and the
expected receipt date for a transfer order.
 

Requisitioning BU
 

Requisition business unit.
 

Purchase Order
 

Purchase order number.
 

Transfer Order Transfer order number.
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Field Description

  

You must enter either the Requester or Entered By field. You must also select a value for the Items Due field.

Note:  If you select Any Time in the Items Due field, and only enter the Requester or Entered By field as your
other search criteria, you’ll be asked to enter additional search values (such as the requisition, purchase order, or
transfer order number) to further narrow your search.

3. Click Search.

Quantity-Based and Fixed-Price Line Differences  
You can view quantity-based items and fixed-priced lines in the same interface. However, there are several differences
between these two line types.

An example of a quantity-based line item is 55 boxes. An example of a fixed-price line item is security services for an
amount of 1000 USD.

Quantity-Based Lines
Quantity-based lines include a physical quantity. Quantity-based lines display the actual quantity in the Quantity field.
For quantity-based lines, the Currency field is not applicable. Instead, the UOM field displays the applicable unit of
measure for the quantity-based item. You can return and correct quantity-based lines.

Fixed-Price Lines
Fixed-price lines don't have a physical quantity. Fixed-price service lines display an editable amount instead of a
quantity in the Quantity field. For fixed-price service lines, the UOM field is not applicable. Instead, the Currency field
displays the currency and the currency is not editable. You can correct fixed-price service lines, but you cannot return
them.

FAQs for Receiving Self-Service Receipts  

Why can't I see the quantity ordered, quantity already received, and the default
receipt quantity?  
Blind receiving was enforced as a profile option for this organization.

Can I search by both purchase order and requisition?  
Yes, you can search by entering values in both the Purchase Order and Requisition fields on the Receive Items page. You
can also search by entering either a purchase order or requisition number.

The search results return a different set of lines based on the combination of requisition and purchase order.
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Can I search a receipt for a range of purchase order lines?  
Yes, you can search the Receive Items page for a specific line or range of lines within a specific purchase order.

Select Advanced to access the advanced search parameters. Then use the between operator to search for a range of
purchase order lines. The range is limited to a maximum of 500 lines.

How can I view the purchase requisition description on the Receive Items page?  
To display the purchase requisition description in the search results of the Receive Items page, you must enable the
column from the View menu.

Select View > Columns Description.

How can I view the manufacturer part number when receiving goods?  
To display the manufacturer part number (MPN) and manufacturer name when receiving goods and performing
associated transactions, you must enable the columns from the View menu throughout the Receiving and Self-Service
Receiving pages.

Select View > Columns > Manufacturer Part Number and View > Columns > Manufacturer.

If there is a single value for the MPN and manufacturer against the record, the values display directly in the record.
However, if there are multiple values for the MPN and manufacturer, you see a Multiple link display in both columns.
Click either the value or the Multiple link to open the Manufacturer Parts window to view the full list of MPNs and
manufacturers.

Note:  If the source document line is a PO line, the application sources the MPN and manufacturer from the PO line
itself. If the source document line isn't a PO line, the application sources the MPN and manufacturer from the item
master record in Oracle Product Hub.

Can I receive lot and serial controlled items through My Receipts?  
No, you can't receive lot and serial controlled items through My Receipts. You have to use the Receive Expected
Shipments page in Oracle Receiving to receive lot and serial controlled items.

Why doesn't Self-Service Receiving have the Add to Receipt button like warehouse
receiving?  
The Add to Receipts functionality is only available within warehouse receiving.

A warehouse manager or receiving agent has the information to identify how receipts should be grouped. In fact,
a warehouse user can even enter a receipt number manually. In warehouse receiving, the user can create a receipt
for purchase orders that belong to a single supplier at a time. Also, receipts can be created for only one inventory
organization. Because of that, the warehouse user needs the ability to access previously created receipts and add to
them.

An employee who accesses Self-Service Receiving doesn't have the necessary information regarding how receipts are
grouped. More importantly, a requester can receive purchase orders belonging to different suppliers and destined for
different inventory organizations. That's why Self-Service Receiving organizes the lines being received and creates the
receipts based on different grouping criteria. Self-Service Receiving always creates new receipts.
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Manage Receipt  

Overview of Manage Receipts  
In this activity, procurement requesters can view the details of receipts that have been created, return the complete or
partial quantity of items received to the supplier, and make modifications to an existing receipt quantity in case of any
errors.

Procurement requesters can:

• Search for existing receipts

• View existing receipts

• Correct receipts

• Return receipts

Note:  For transfer order receipts, the following exceptions apply:

• You can't perform corrections for transfer order receipts.

• You can only perform returns against transfer order receipts with an inventory destination (interorganization
transfer).

• You must set the RCV_SS_ALLOW_INV_DEST_RECEIPTS profile option to enable inventory destination
receipts for Self-Service Receiving.

In the Setup and Maintenance work area, use this path to set up your receiving profile options:

• Offering: Manufacturing and Supply Chain Materials Management

• Functional Area: Receiving

• Task: Manage Receiving Profile Options

To manage self-service receipts, select Navigator > Procurement > My Receipts. From the task pane, click Manage
Receipts.

Note:  You can also create receipts for requisitions when you're not the requester or preparer.

Related Topics
• Enable Self-Service Receiving on the Behalf of Others

Self-Service Transfer Order Returns  
You can request a return against an inventory destination transfer order through the Manage Receipts Self-Service
interface.
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The following aspects are important when returning transfer orders:

• Return transfer order process

• Physical material return

• Corrections to returned transfer orders

• Return exceptions for transfer orders

Return Transfer Order Process
Receiving associates return transfer orders with the original transfer order, and the physical return of the material is
optional.

When you initiate a return against a transfer order, the application creates a new transfer order with a transfer type of
return transfer order. If the physical return of material is required, the transfer order is passed to Oracle Shipping. If the
physical return of material is not required, the transfer order does not pass to Shipping, and instead is set to a status of
closed.

During the return process, Receiving calculates the price and tax for the return transfer order before submitting the lines
for processing. The application obtains the tax and prices amounts from the original transfer order and creates them in
reverse.

Physical Material Return
The Physical Material Return Required  check box displays on the Return Lines user interface. If you deselect this field,
the return is considered an accounting only return. If you select this field, transactions are created for the physical return
of the material.

For returns that don't require physical return of material, shipment lines and reservations aren't created. The transfer
order line is set to a status of closed automatically, and the application does not update the shipped or received
quantity. You can use the transfer order document for tax, accounting, and audit trail purposes.

For returns that require physical return of material, shipment lines and reservations are created. You can pick, pack, and
ship physical material returns.

Corrections to Returned Transfer Orders
When material from a transfer order is put away, you can no longer correct the receipt quantity. However, you can
correct the receipt quantity on a transfer order prior to putting away the transaction.

Return Exceptions for Transfer Orders
Here are the exceptions for returns against transfer orders:

• When you initiate a return against a transfer order, you can no longer correct the returned quantity.

• You cannot combine transfer order return lines with other purchase order or RMA return lines on the same
return receipt.

• You cannot perform return transactions for an intraorganization transfer order which moves material from
subinventory to subinventory within an organization.

• The application does not initiate transfer order return transactions if the material is not physically available. For
example, if other reservations exist for the same material.

• You can only return inventory destination transfer orders. You cannot return expense destination transfer
orders.
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FAQs for Returning Self-Service Receipts  

What's the difference between returning fixed-price lines and quantity-based lines?  
You cannot return fixed-price lines. You can only return quantity-based lines.

What happens if I select the Physical Material Return Required check box?  
Transactions are created for the physical return of the material, and shipment lines and reservations are created. You
can pick, pack, and ship physical material returns.

If you don't select this check box, the return is considered an accounting only return. Shipment lines and reservations
aren't created, the transfer order is set to a status of closed automatically, and the shipped or received quantities aren't
updated.

Can I return both fixed-price and amount-based lines through Self-Service Receiving?
 
No, you can only return amount-based received lines through Self-Service Receiving.

Confirm Receipts Process  

Confirm Receipt Process  
The Confirm Receipts workflow sends notifications through the Web or email to requesters or buyers who create
requisitions in Oracle Fusion Cloud Self Service Procurement. The workflow informs the requesters or buyers that they
should have received an item.

The most important aspects of the Confirm Receipts workflow process include:

• Notification criteria

• Notification options

• Notification delivery

Notification Criteria
The Confirm Receipts workflow sends notifications for items with a destination type of Expense, a routing of Direct
Delivery, and a need-by date that's equal to or later than today's date.

Notification Options
You can have notifications sent to the requester for them to respond to the receipt status of an order. These
notifications are called confirm receipt notifications.
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The options available to the requester who receives a purchase order notification include:

• Fully received

• Not received

• Receive up to amount invoiced due to an invoice match in Oracle Payables

Note:  If the requester selects Not Received, a notification can be sent to the buyer regarding the requester's failure
to receive the items on the purchase order. Later, when the requested items are available to be received, the buyer
can either receive the items or send a notification to the requester again to complete the receiving process at the
requester's end.

The options available to the requester who receives a transfer order notification include:

• Receive in full

• Did not receive

Notification Delivery
When a purchase order is created, the line on the purchase order must have a matching level of 3-way matching. You
must submit the Confirm Receipts Workflow Select Orders process to send the notifications to the requesters.

Workflow sends notifications when either of these occur:

• At least one day must have lapsed from the need-by date on the order line.

• An invoice is matched to the purchase order line in payables, and the invoice itself is on quantity or amount
receiving hold.

More specifically, the Confirm Receipts workflow sends notifications when the purchase order fulfills the following
criteria:

• Purchase order has an expense destination

• Match Approval Level is 3 Way

• Receipt Routing is Direct delivery

• Purchase order has a deliver-to person ID on the distributions

• Purchase order past due date must be more than one day

• If the profile value RCV_SSP_NOTIF_INCLUDE_PAST_DUE_ORDERS is set to Yes, then the workflow includes all
POs which are past due

• If the profile value RCV_SSP_NOTIF_INCLUDE_PAST_DUE_ORDERS is set to No, then the notification is raised
only if:

◦ There's an invoice corresponding to the PO schedule, and

◦ The invoice is placed on hold and the hold code is QTY REC or AMT REC

Based on the need-by and run dates, here are examples of when workflow sends the notification for a purchase order:

• If the need-by date on the PO schedule is 22 December and you run the Confirm Receipt process on 23
December, then workflow sends the notification.

• If the need-by date on the PO schedule is 23 December and you run the Confirm Receipt process on 23
December, then workflow doesn't send the notification.
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• If the need-by date on the PO schedule is 15 December and you run the Confirm Receipt process on 23
December, then workflow sends the notification.

For transfer orders, notifications are only available for expense destination transfer orders sourced from a requisition
line. The transfer order must also have direct receipt routing.

To use the Confirm Receipt notification workflow for transfer orders, enable the Transfer orders included for Confirm
Receipt Process profile option.

In the Setup and Maintenance work area, use the following to set up your receiving profile options:

• Offering: Manufacturing and Supply Chain Materials Management

• Functional Area: Receiving

• Task: Manage Receiving Profile Options

Self-Service Items Not Received  
During self-service receipt, a requester can involve the buyer when unable to receive an order. The requester who
receives the purchase order notification clicks the Not Received button as part of the Confirm Receipts workflow.

Selecting the Not Received button triggers a notification to the buyer on the failure to receive items by the requester.
As a buyer, the workflow lets you receive the notification as part of your worklist. The notification provides details on
the requester and the order against which the requester didn't receive items.

When the requested items become available in the future, the buyer can either receive the items or send a notification
to the requester again to complete the receiving process at the requester's end.

Self-Service Transfer Order Receipt Confirmation  
For expense destination transfer orders sourced from requisition lines, use the Transfer Order Receipt Confirmation
page to confirm receipt of a transfer order shipment.

When you open the workflow notification letting you know that an item is ready to be received, you are transferred to
this page. Select the Receive in Full button to confirm the receipt of goods and automatically create a receipt. You can
view your created receipt on the Self-Service Manage Receipts page. If you did not receive your shipment, select the Did
Not Receive button.

Note:  To use the Confirm Receipt notification feature for transfer orders, enable the Transfer orders included for
Confirm Receipt process profile option. In the Setup and Maintenance work area, use the Define Receiving task to set
up your receiving profile options.

The Transfer Order Receipt Confirmation page displays the lines to receive for a transfer order shipment. In the Lines to
Receive section of the page, view your data from the transfer order shipment line. The following table shows the data
you can view for your transfer order shipment line.
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Attribute Description

Shipped quantity
 

Quantity available in the shipment to receive. If there are multiple transfer order distributions, you will
see a separate line for each distribution.
 

Received quantity
 

Quantity already received against the shipment and distribution.
 

Requisitions
 

Requisition number tied to the transfer order.
 

FAQs for Confirm Receipts  

What are the Confirm Receipts workflow notification responses?  
Here are the possible Confirm Receipts workflow notification responses and their associated roles:

• Receive in full (Requester or Buyer)

• Receipt up to Invoiced (Requester or Buyer)

• Did not receive (Requester or Buyer)

• Re-notify requester (Buyer)

• Acknowledge (Manager after escalation)

If you select a receive outcome of Receive in Full or Receipt up to Invoiced Amount, the task is completed. If you
select Did Not Receive, the task is assigned to the buyer. If you choose Re-notify Requester, the task is assigned back
to the requester.

This history tab of the notification shows the status history of this workflow through possible reassignment and
notifications.

Why isn't the Receive up to Invoiced Amount button enabled for my notification?  
This button is disabled because when the notification was issued, the purchase order wasn't yet invoiced.

Let's look at this example. A notification is sent on 13-Nov-2020. At that time, the
RCV_SSP_NOTIF_INCLUDE_PAST_DUE_ORDERS profile option was set to Y, but there were no invoices created for any
of the schedules of this purchase order. Since the profile option is Y, the notification was raised. However, since there
are no invoices, the Receive up to Invoiced Amount button is disabled because the difference between the amount
billed and amount received is zero.

On 5-Dec-2020, the invoices are created. These invoices are placed on hold on 6-Dec-2020. The button is still disabled
because when the task was created on 13-Nov-2020, there were no invoices.

To reissue a new notification based on the current state of the purchase order, complete these steps:

1. Click the Did Not Receive button on the old notification. This closes that task without creating a receipt.
2. Run the Confirm Receipt scheduled process.
3. Log in to the worklist as the original requester of the purchase order (not the escalated manager).
4. Open the notification details and the Receive Up to Invoiced Amount button is now enabled.
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What happens if I select the Did Not Receive button on the Confirm Receipts
notification?  
The task is assigned to the buyer.

How can I inform the buyer when the requester selects the Did Not Receive option?  
You must first enable the Escalate Self-Service Receiving for Items Not Received feature to use this functionality.

To enable the Escalate Self-Service Receiving for Items Not Received feature, go to the Manufacturing and Supply
Chain Materials Management offing in the Setup and Maintenance work area.

1. In the Setup and Maintenance work are, select the Manufacturing and Supply Chain Materials Management
offering.

2. On the Manufacturing and Supply Chain Materials Management page, click the Change Feature Opt In link.
3. On the Opt In: Manufacturing and Supply Chain Materials Management page, select the Features icon in the

Receiving row.
4. On the Edit Features: Receiving page, select the Enable check box for the Escalate Self-Service Receiving for

Items Not Received feature.
5. Click Done.

Why aren't I receiving Confirm Receipt notifications for my purchase order?  
The Confirm Receipts workflow sends notifications when the following criteria is fulfilled on the purchase order:

• The destination type on the purchase order is Expense.

• The receipt routing is Direct Delivery.

• The match approval level is 3 Way.

• The purchase order must have a deliver-to person on the distribution.

• The purchase order past due date should be more than one day.

• If the RCV_SSP_NOTIF_INCLUDE_PAST_DUE_ORDERS profile value is Y, then it includes all purchase
orders that are past due. If the RCV_SSP_NOTIF_INCLUDE_PAST_DUE_ORDERS profile value is N, then the
notification is raised only if:

◦ There's an invoice corresponding to the purchase order schedule.

◦ The invoice is placed on hold and the hold code is QTY REC or AMT REC.

The Confirm Receipts scheduled process generates notifications for all self-service purchase orders that are past their
promised date (or need-by date if the promised date isn't provided). You can schedule the Confirm Receipts process for
a Daily run to create timely notifications.

Why did I receive multiple Confirm Receipt notifications for the same purchase order
schedule?  
Let's look at an example for why you might receive multiple Confirm Receipt notifications for the same purchase order
schedule.

If you run the Confirm Receipts process on 8-Dec-2020, the process checks all purchase orders that have a due date
as 7-Dec-2020 or less (with receipt routing as Direct Delivery, match option as 3 Way, a requester present on the
purchase order, and destination type as Expense). Then, the process checks if there is an existing notification assigned.
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If the notification is already assigned, a duplicate isn't sent. When a notification is sent, it's up to the requester to act
on it manually. The requester must go to the work list and receive using buttons or the email actions, such as Fully
Received or Did Not Receive. If the notification is sent on 8-Dec-2020 and the original requester doesn't respond by
16-December-2020, then another reminder email is sent. If the requester doesn't respond by 23-December-2020, the
current notification expires and it's escalated to the original requester's manager.

Also, it's possible to receive a notification two days in a row if an open notification is closed with actions pending, but
not done. For example, if the requester selects the Did Not Receive option and closes the notification. In this case, the
application sends the notification again during the next run of the Confirm Receipts process.

What happens if the requester doesn't respond to a Confirm Receipts workflow
notification?  
When a notification is sent, it's up to the requester to act on it manually. Notifications by default have an expiration
date of 1 week, after which the notification escalates to the line manager of the requester. After 1 week of escalation, the
notification expires.

When a notification expires, the purchase order becomes eligible for the Confirm Receipt workflow again. And if still not
received, the purchase order requester is sent another notification.

What security setups are required to run or view notifications from the Confirm
Receipt process?  
Here are the required security setups for running the Confirm Receipt scheduled process:

• You need the Confirm Receiving Receipt Process privilege
(RCV_CONFIRM_RECEIVING_RECEIPT_WORKFLOW_PROCESS_PRIV) to submit the Confirm Receipts scheduled
process.

• You need the duty role and job roles associated with this privilege.

A requester or preparer (of the requisition) can view the confirm receipt notification:

• You need the View Receiving Receipt Notification (RCV_CONFIRM_RECEIVING_RECEIPT_NOTIFICATION_PRIV)
to view the notifications.

• You need the duty role and job roles associated with this privilege.

Does the quantity to invoice show in the Confirm Receipt notification lines if the
quantity has already been invoiced?  
No, the invoiced quantity doesn't appear on the Confirm Receipt notification. If any purchase order quantities are
invoiced, the quantity to receive appears on the purchase order schedules in the detail view.
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19  Responsive Self-Service Receiving
Application

Responsive Self-Service Receiving Application  
You can access the Responsive Self-Service Receiving application on a mobile device, tablet, laptop, or desktop web
browser.

Robust search capabilities let you search across multiple document types including purchase order, transfer order and
advance shipment notice (ASN). You can use the predefined search filters to quickly identify your orders to receive.
Based on your organizations receiving process, you can receive your items immediately with a single tap on your mobile
device, or you can choose to add information such as attachments. After performing a receipt, you can easily search for
your receipt and perform actions such as updating the receipt quantity or returning items to a supplier.

The application facilitates quick receipts of goods and services while on the move, enabling you to complete tasks
efficiently on your mobile device anytime and anywhere. The screen appearance dynamically changes based on the
screen size and orientation of the device being used to view it. The application's responsive design makes the self-
service receiving process easy, quick, and flexible.

The Self-Service Receiving Responsive Application has these benefits:

• Quickly search for your orders to receive by using enhanced search capabilities such as smart filters, fuzzy
matching, and search relevance ranking.

• Flexibility to receive multiple document types including purchase order, transfer order, and advance shipment
notice.

• Receive items immediately using Receive Now or enter receipt details using Receive with Details.

• Resolve receipt exceptions immediately with the ability to update received quantities and return received items
to suppliers.

Note:  Currently, only orders with an expense destination type can be received. Also, you can only receive orders
where you are the requester.

My Receipts (New) Navigation  
Use the My Receipts (New) navigation menu to access the Orders to Receive page and view your receipts in the
Responsive Self-Service Receiving application.

The My Receipts (New) navigation menu lets you quickly access the Responsive Self-Service Receiving Application.
Tapping on the My Receipts (New) navigation entry takes you to the Orders to Receive page. This is the main landing
page where you can search for your orders and receive your items.

Note:  To access the My Receipts (New) navigation entry point, you must configure roles that contain the Receiving
Self-Service Responsive Application User Duty (ORA_RCV_RECEIVING_SELF_SERVICE_PWA_USER_DUTY) duty role.
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Orders to Receive  
On the Orders to Receive page in the Responsive Self-Service Receiving application, you can search for your orders
across requisitioning business units provided you have the appropriate requisitioning business unit data access.

You can search for your orders by a variety of attributes such as item, requisition, supplier, purchase order, transfer
order, shipment, and so forth. Smart filters (Chips) let you quickly search on predefined search attributes such as
expected date, document type, item, requisition, and requisition line. Once you select a specific chip, it displays in the
search fields and the search results are filtered accordingly. A navigation bar is displayed at the bottom of the page
enabling you seamlessly switch between the Orders to Receive and My Receipts pages.

You can receive orders expected in the past, expected today, and expected in the future. Orders to receive expected
in the past are displayed for the past 30 days. A badge displays on the card indicating if the order has been partially
received. Additionally, you can view the expected date of the order, item, item description, source document, supplier,
and quantity or amount. You can receive document types including purchase order, transfer order, and ASN. Lastly, you
can receive amount-based and description-based purchase orders.

My Receipts  
After you have successfully created your receipt, use the My Receipts page to view your receipt.

A navigation bar displays at the bottom of the page letting you navigate between the Orders to Receive and My Receipts
pages. Within the My Receipts page, you can search on a variety of attributes such as item, receipt number, purchase
order, transfer order, supplier, and so forth. Smart filters are provided that let you further refine your search. Clicking on
the card lets you view the details of your receipt such as attachments, source documents, and manufacturer details.

Responsive Self-Service Receiving Search Capabilities  
Use elastic-based smart search and smart filters to quickly search for your orders to receive in the Responsive Self-
Service Receiving application.

Elastic-Based Smart Search
Elastic-based smart search supports additional searchable attributes, built-in fuzzy matching, and enhanced relevance
ranking of search results. This provides a more powerful search experience with more potential matches compared
to the web-based application. You can refine your search results by adding more than one keyword. The application
shows you automatic search suggestions based on your recent search history. A single search can search across source
documents such as purchase orders, transfer orders, and advance shipment notices.

Smart Filters (Chips)
Smart filter-enabled pages include a single search field at the top of the page with filters that display as suggestion
chips. Smart filters also include counts showing how often a specific value occurs. For example, the item chip shows
how often a specific item occurs in the search results.

116



Oracle Fusion Cloud SCM
Using Receiving

Chapter 19
Responsive Self-Service Receiving Application

Here are the available smart filters:

• Item: Filter by item

• Document Type: Filter by document type of purchase order, transfer order, and ASN

• Expected Date: Filter by start date and end date

• Exclude 2-Way Match Orders: Include or exclude 2-way match orders

• Expected today: Filter orders expected today

• Expected in the past: Filter orders expected in the past

Receive Using the Responsive Self-Service Receiving
Application  
Use the Receive Now or Receive with Details actions on the Orders to Receive page to receive items with or without
additional details using the Responsive Self-Service Receiving application.

Receive Now
You can immediately receive your orders by tapping the Receive Now button. You can quickly receive your orders
without having to enter specific details about your receipt. In the event you need to enter additional receipt details, you
can tap the Receive with Details icon to the right of the Receive Now button. Once you've performed the Receive Now
action, you're presented with a toast confirmation message indicating that the receipt has been successfully created.

Receive with Details
Based on your organizations receiving process, you may need to view details associated with the order or modify or
enter additional information when performing a receipt. For example, you can adjust the receipt quantity or enter
attachments such as an invoice or packing slip. In such cases, you should use the Receive with Details action. Tapping
this button opens the New Receipt page allowing you to enter additional details when performing a receipt.

Note:  Configure the Blind Receiving for Self-Service Procurement Enforced profile option to specify whether
the Receive Now button or the Receive with Details button displays as the primary action on the Orders to Receive
page. A profile value of No indicates that the Receive Now button displays as the primary action on the Orders to
Receive page. An icon displays allowing you to Receive with Details. A profile value of Yes indicates that the Receive
with Details button displays as the primary action on the Orders to Receive page. The Receive Now button won't be
displayed.

New Receipt  
The New Receipt page in the Responsive Self-Service Receiving application is segmented into several regions letting
you view and enter comprehensive information for your receipt.

• Add details of your receipt: View and modify the receipt quantity and item UOM.

• Attachments: Add files and URLs such as an invoice or packing slip.
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• Receipt details: Enter details such as tracking number, packing slip, notes, and receipt date. The tracking
number defaults from the ASN if provided by the supplier. The receipt date automatically defaults to the current
date, but it can be modified if required.

• Additional information: Enter descriptive flexfield information associated with the receipt.

• More details: View details of the order including purchase order, transfer order, shipment, unit price, project
number, and so forth.

• Manufacturer details: View the manufacturer and manufacturer part number associated with an item.

Once you have entered the receipt details, tap the Create button at the bottom of the page to create your receipt. You’ll
receive a confirmation toast message displaying the associated receipt number.

Note:  To display an item’s unit price, configure the Display Item Unit Price in Self-Service Receiving profile option.
A profile value of No indicates that the item's unit price won't display on the New Receipt page. A profile value of Yes
indicates that the item's unit price will display on the New Receipt page.

Update Receipts Using the Responsive Self-Service
Receiving Application  
In the Responsive Self-Service Receiving application, you have the flexibility to update the receipt quantity.

For example, the receipt quantity may have been entered incorrectly and there's a need to update the receipt quantity.
Additionally, you can specify the date the receipt quantity was revised. The Revised Quantity and Date Revised fields
honor all quantity and date validations.

Return Receipts Using the Responsive Self-Service
Receiving Application  
In the Responsive Self-Service Receiving application, you can return a receipt to the supplier if needed.

For example, the supplier may have shipped an incorrect item, or the item was damaged. When creating a return, you
can specify the return quantity, reason, RMA, return date, and notes. You can also select whether a debit memo should
be created for the supplier return transaction. The Return Quantity and Return Date fields honor all quantity and date
validations.
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Create Index Definition and Perform Initial Ingest to
OSCS  
For the Responsive Self-Service Receiving application, you must perform the initial ingest. This requires submitting the
scheduled process job to create the index definition and performing the initial ingest to Oracle Search Cloud Service
(OSCS).

This process ingests purchase order expected receipts, transfer order expected receipts, advanced shipment notice
expected receipts, and receiving transactions. This is a prerequisite step to search and receive orders in Self-Service
Receiving.

Ensure that your administrator provides you with the Manage Scheduled Job Definition privilege before performing
these steps to complete the initial ingestion of existing orders and receipts into the index and enable search. New orders
and receipts created after these steps are automatically inserted into the search index.

1. Log in as the Supply Chain Application Administrator or Procurement Application Administrator user.
2. Navigate to Tools > Scheduled Processes, then click Schedule New Process.
3. Search and select the process name: ESS job to create index definition and perform initial ingest to OSCS.

Parameter values for index name to reingest:

◦ fa-scm-rcv-expected-po-receipts

◦ fa-scm-rcv-expected-asn-receipts

◦ fa-scm-rcv-expected-to-receipts

◦ fa-scm-rcv-transactions

What to do next

Note:  If you don't specify any index names while submitting the process, the process runs for all predefined indexes.
We highly recommended that you create indexes for the index names listed here.

Ingest Receiving Search Indexes  
Use the Ingest Receiving Search Indexes scheduled process to ingest receipts performed outside of the Responsive
Self-Service Receiving Application.

For example, a receipt can be created through the Receiving Receipt Import FBDI, Receiving Receipt Requests REST
API, or the existing Receive Expected Shipments page. In these cases you need to run this scheduled process to ensure
your receipts are ingested. Additionally, inbound shipments such as advance shipment notices (ASN) and transfer
order shipments can be created. In these cases, you also need to run this scheduled process to ensure your inbound
shipments are ingested. It's recommended to run this process frequently to ensure your receipts and shipments are
ingested in a timely manner. Receipts created through the Self-Service Receiving Responsive Application are ingested
automatically.
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To ingest receiving search indexes, complete these steps:

1. In the Scheduled Processes work area, select Schedule New Process.
2. Search for and select the Ingest Receiving Search Indexes process.
3. Click OK.
4. Enter your specifications in the Process Details dialog box.
5. Click Submit.

How You Set Up the Responsive Self-Service Receiving
Application  
Before using the Responsive Self-Service Receiving Application, you must configure duty roles and set up profile
options and inventory transaction reasons.

To access this feature, you must configure roles that contain the duty role Receiving Self-Service Responsive Application
User and assign them to users. You can configure the role from the Oracle Security Console by logging in as IT Security
Manager.

You also need to set up:

• Receiving profile options

• Administrator profile options

• Inventory transaction reasons

Receiving Profile Options
Use the Manage Receiving Profile Options task to set up these receiving profile options:

• Blind Receiving for Self-Service Procurement Enforced: Determines whether the Receive Now or Receive
with Details button displays as the promoted button.

◦ No: Indicates that the Receive Now button displays as the primary action on the Orders to Receive page.
An icon displays allowing you to Receive with Details.

◦ Yes: Indicates that the Receive with Details button displays as the primary action on the Orders to
Receive page. The Receive Now button won't be displayed.

• Display Item Unit Price in Self-Service Receiving: Determines whether the item’s unit price displays on the
New Receipt page.

◦ No: Indicates that the item's unit price won't display on the New Receipt page.

◦ Yes: Indicates that the item's unit price will display on the New Receipt page.

Administrator Profile Options
Use the Manage Administrator Profile Values task to confirm the values for these profile options:

• Enable/Disable Search Ext Framework (ORA_FND_SEARCH_EXT_ENABLED) profile is set to Yes.

• Row fetch count for initial ingest process (ORA_FND_SEARCH_FETCH_COUNT) profile is set to 100.
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Inventory Transaction Reasons
When returning items to a supplier, you have the option to specify the reason for return. You can define the reason
name and reason type using the Manage Inventory Transaction Reasons setup task. When defining a new transaction
reason, select Supplier return as the reason type.

How Your Requisition Preparer Can Receive Goods and
Services  
You can allow your requisition preparer to receive goods and services using the responsive Self-Service Receiving
application.

You can allow your requisition preparer to receive goods and services using the responsive Self-Service Receiving
application

Assign the Create Receipt for Procurement Preparer with the Responsive Self-Service Receiving Application privilege
(RCV_CREATE_RECEIPT_PROCUREMENT_PREPARER_PWA) to your requisition preparers to allow them to receive
goods and services using the Responsive Self-Service Receiving application on their mobile device, tablet, or desktop.
This privilege is not delivered as a seeded privilege. You must configure roles that contain the Create Receipt for
Procurement Preparer with the Responsive Self Service Receiving Application privilege.

Related Topics
• Orders to Receive
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